Contents

Using this Documentation ix
  Instruction Conventions ix
  Typographical Conventions x
  Illustrative Material xi

Chapter 1 Introduction  1
  About this Guide  1
  If You Need More Information  3
  Professional Responsibility  4
  Contacting Technical Support  4

Chapter 2 A Quick Tour  5
  Understanding Key Terms  5
  Typical Tasks  6
  Starting the Program  6
  Opening a Publication  8
  Using the Program in Accessibility Mode  10
  Understanding the Main Window  12
  Setting Program Preferences  14
  Quitting the Program  14

Chapter 3 Working with the Table of Contents  15
  Displaying the Table of Contents  15
iv Contents

Understanding Table of Contents Hierarchy 16
Understanding Uses for the Table of Contents 16
Browsing Publication Components 17
Navigating and Viewing Publication Content 18
Limiting Content Displayed for Viewing 19
Synchronizing the Table of Contents 20

Chapter 4 Viewing Content 23
Displaying the Document and Reference Panes 23
Understanding the Document and Reference Panes 24
Understanding Content-Navigation Aids 24
Synchronizing the Document Pane 27

Chapter 5 Understanding Search Mechanisms 29
Advanced Query Window 29
Query Templates 31
Query Dialog Box 33

Chapter 6 Formulating a Query 37
Searching for a Specific Word 37
Searching for Variations of a Word 38
Searching for Words in Relationship 39
Searching for an Exact Word String (Phrase) 42
Searching for Multiple Words within a Given Proximity of Each Other 42

LexisNexis CD User’s Guide
Contents v

Building a Query from Words in the Active Infobase 44
Understanding Natural Language Searching 45

Chapter 7 Changing Search Range 49
Searching Selected Divisions of the Active Publication 49
Searching a Structural Element (Scope) in One or All Open Publications 51
Searching All Open Publications 54
Searching All Publications in a Given Directory 55

Chapter 8 Extending Search Functionality 57
Clearing a Search 57
Viewing Search History and Rerunning a Previous Search 57
Editing a Search 59
Searching Updated Case Content on the lexis.com Service 62

Chapter 9 Viewing Search Results 65
Understanding Post-Search Changes to the Main Window 65
Understanding Means of Viewing Search Results 65
Limiting Content Displayed After a Search 70

Chapter 10 Printing and Reusing Content 73
Printing Content 73
Transferring Content to Other Applications 80

LexisNexis CD User’s Guide
Chapter 11 Checking the Current Status of Information 85
   The Shepard’s® Citations Service 85
   Checking a Citation 85

Chapter 12 Linking to the lexis.com® Service 89

Chapter 13 Customizing Publication Content 91
   Creating and Opening Shadow Files 91
   Annotating Content in Shadow Files 92
   Bookmarking Content in Shadow Files 94
   Highlighting Content in Shadow Files 96

Chapter 14 Managing Data, Rights, and Peripheral-Software Integration 101
   Managing Library Data 101
   Managing Library Access Rights 111
   Managing Peripheral-Software Integration 112

Appendix A Working with the Program Interface 117
   Understanding the Menus 117
   Customizing the Interface 135

Appendix B Working with Query Templates 137
   Analysis Query Template 137
   Case Query Templates 138
   Code Query Template 142
Contents vii

Forms Query Template 144
Guided Search Query Template 146

Index 147
Using this Documentation

The instructional material in this documentation focuses on the tasks made possible by the program features, as reflected in the Table of Contents. To instead locate material based on the features themselves, please refer to the Index.

Instruction Conventions

The bulk of this documentation consists of step-by-step instructions for performing the tasks made possible by the program. Many of these tasks can be initiated in a number of ways; when this is the case, the instructions outline several means of task initiation, always citing the most universally applicable first. Thus, the first cited path to task initiation is generally via either drop-down menu or keyboard shortcut, as these means of task initiation are accessible to broadest population of users including those who employ only the keyboard in order to accommodate some form of physical impairment.

At certain junctures when performing tasks made possible by the program, you made need to choose a single action from among multiple actions. Such junctures are indicated by bulleted items following a given numbered step, each of which is separated by a paragraph consisting solely of the word OR.

**Example:** The following illustrates the method used to indicate mutually exclusive options within instructional material.

1. Access the Advanced Query window or desired query template, as applicable:
   - To access the Advanced query window, open the Search menu then choose Advanced Query.
   - **OR**
   - To access a query template, open the Search menu then choose the corresponding name from the bottom of the menu.

At other junctures, you may be instructed to choose one or more options from among multiple options. Such junctures are indicated by bulleted items following a given numbered step.
Finally, because many actionable interface elements such as options and buttons in dialog boxes can be activated in a number of ways — for example, via pressing the Spacebar or pressing Enter — non-specific language, such as activate or choose, as opposed to specific language, such as press Enter, is generally used to describe taking action in relation to such elements.

**Example:** The following illustrates the method used to indicate non-mutually exclusive options within instructional material.

2 In the Show area, indicate whether you want to hide or show the following in printed material, inserting a checkmark in the corresponding check box to show the item or clearing a checkmark to hide the item:
- **Query results** (hit highlighting when printing either publication content or the hit list)
- **Inline headings** (full source information for content)
- **Link attributes** (visual enhancement, typically underscoring, used to indicate a link in publication content)
- **Hidden text** (material specific to the production of the active publication)

Typographical Conventions

The following typographical conventions — designed to help you easily locate key actions within instructions — are used throughout this documentation:

- **Boldface** is used to highlight areas of the program interface requiring some action on your part, as in “Activate the Help button.”
- **Boldface small caps** are used to highlight keystrokes, as in “Press ENTER.”

**Example:** The following illustrates the language used to indicate taking action in relation to interface components that can be activated in a number of ways.

3 In the message indicating that switching between operating modes requires a system reboot and prompting you to confirm your desire to switch modes, choose Yes.
Illustrative Material

This documentation includes graphical images designed to highlight certain features of the program. Note that any names or other data appearing in these images are for illustrative purposes only, and any similarity to real persons or other entities is entirely coincidental.
Chapter 1  Introduction

As a legal researcher, your job requires you to track down information on specific legal issues, find related cases, locate analytical material to assist in preparing a brief, or find a specific case or statute. The LexisNexis® CD application on the Folio 4 platform transforms your personal computer into an electronic research tool, enabling you to find the information you need quickly and efficiently.

You can use the LexisNexis CD application to perform a variety of simple and complex searches, enabling you to quickly locate the information you need. The system provides access to a large collection of documents, as well as direct access to the lexis.com® research system (if you are a current subscriber).

Once you find the information you need, you can print or export it for reuse at a later time.

About this Guide

This User’s Guide contains all the information you need to use the LexisNexis CD application. It assumes that you have already installed the software. If you haven’t yet done so, detailed installation instructions can be found in the Quick Installation Guide that was packaged with your software.

Contents

This Guide begins with “A Quick Tour,” Chapter 2, which summarizes some key terms and concepts that will help you make efficient use of the LexisNexis CD application. The chapter also outlines typical tasks performed using the program, details information related to using the program is accessibility mode, provides instructions on starting and quitting the program, introduces you to the program’s main window, and provides basic information on setting preferences.

* Subject to Terms and Conditions
2 Introduction

Chapter 3, “Working with the Table of Contents,” describes the table of contents hierarchy. It also explains how to browse and view publication content from the table of contents as well as how to use the table of contents to limit the amount of content displayed for viewing. Finally, the chapter describes the options for synchronizing the table of contents.

Chapter 4, “Viewing Content,” describes the Document and Reference panes. It also explains how to navigate content, footnotes, and supplements and how to synchronize the Document pane to your location in the table of contents.

Chapter 5, “Understanding Search Mechanisms,” introduces the various search mechanisms offered by the application and outlines how to use these mechanisms.

Chapter 6, “Formulating a Query,” details the various types of queries that can be crafted to find the information you need and provides information on natural language searching.

Chapter 7, “Changing Search Range,” outlines ways of broadening or narrowing the scope of a search from the default of all content in the active publication.

Chapter 8, “Extending Search Functionality,” discusses additional search functionality, including clearing a search, editing a search, viewing search history, re-running a previous search, and searching updated case content on the lexis.com service.

Chapter 9, “Viewing Search Results,” describes search-related changes to the main window. It also provides instructions on viewing search results from different levels of detail. Finally, the chapter explains setting your preference with regard to the display of content following a search.

Chapter 10, “Printing and Reusing Content,” explains how to print and export all or part(s) of publication content, including the table of contents and/or hit list.

Chapter 11, “Checking the Current Status of Information,” introduces the Shepard's® Citations Service and describes how to access and use that service from the LexisNexis CD application.
Chapter 12, “Linking to the lexis.com® Service,” describes the lexis.com research system and provides instructions on linking directly to that system from the LexisNexis CD application.

Chapter 13, “Customizing Publication Content,” outlines the process of creating special copies of publication content, called shadow files, which you can then customize by attaching notes, inserting bookmarks, and highlighting information.

Chapter 14, “Managing Data, Rights, and Peripheral-Software Integration,” provides detailed instructions on administering library data storage and permissions along with peripheral software integration to suit your work environment over time.

The User’s Guide also includes two appendices containing reference material designed to further hone your use of the program:

Appendix A, “Working with the Program Interface,” provides detailed information on the program menus and toolbar and includes instructions for customizing various aspects of the interface, such as pane size, view tab location, and display font.

Appendix B, “Working with Query Templates,” describes the query templates most commonly provided with the various publications and outlines common search scenarios for a number of these templates.

If You Need More Information

This documentation assumes that you are familiar with basic Windows® functionality, such as moving and sizing windows, arranging overlapping windows, and navigating within windows. If you have questions about performing such tasks, refer to your Windows documentation. You can also find helpful information by opening the Start menu then choosing Help.

The LexisNexis® CD application also provides an electronic Help file to assist in answering questions you may have while using the application.
Introduction

To access electronic Help

Press F1.

OR

Press ALT + H to activate the Help menu then choose Contents.

Professional Responsibility

The materials that you are licensing are designed to assist you in your professional practice. It is still your responsibility to review the documents and to research results in order to determine their accuracy and suitability for your purposes. The materials are not intended to be a substitute for the exercise of your professional judgment.

All information provided in this document is general in nature and is provided for educational purposes only. It should not be construed as legal advice. For legal advice applicable to the facts of your particular situation, you should obtain the services of a qualified attorney licensed to practice in your state.

Contacting Technical Support

Technical Support is available 24 hours a day, 7 days a week. When calling for technical assistance, please be at the computer on which the program is running, and please have your account number, found on your packing slip, ready.

U.S. and Canadian Customers: 1-800-223-5297

International Customers: 1-937-859-5398
Chapter 2  A Quick Tour

Before using the *LexisNexis® CD* application for the first time, it will be helpful to familiarize yourself with some basic information about the program, including the following:

- Key terms
- Typical tasks
- Starting the program
- Opening a publication
- Using the program in accessibility mode
- Components of the main window
- Setting preferences
- Quitting the program

This chapter outlines each of these topics and, where applicable, provides instructions for performing the given task.

Understanding Key Terms

The following terms describe the information hierarchy used by the *LexisNexis CD* application. Terms appear in hierarchy order, from largest unit to smallest:

- **Library** — The highest level of organization. A library can encompass multiple products contained on one or more CDs.
- **Product** — One or more practice-related publications sold together as a unit.

**Note:** Some publications may be included in more than one product. Therefore, products are not represented in the table of contents hierarchy, and the only time you are likely to see products referenced is when installing the program or initiating rights to additional components of a previously installed library release (see “Managing Library Access Rights,” on page 111).

- **Publication** — A title generally corresponding to a printed publication.
- **Infobase** — Searchable text and graphics, typically of a single publication.
• **Record**—The smallest searchable, printable, and exportable unit of content, generally corresponding to a heading or to one or more paragraphs of body text following a heading.

Other important terms describe key functions or features of the *LexisNexis CD* application. These terms include the following:

• **Link**—An electronic cross-reference that enables you to quickly access the referenced content. Links appear in content as colored, underlined text.

• **Query**—A defined term or set of terms used to locate relevant content.

• **Query template**—A publisher-supplied search mechanism that allows you to easily formulate a query focusing on a specific type of content, such as treatise, case, or code.

• **Hit**—An occurrence of a defined query in publication content.

**Typical Tasks**

Following, in no particular order, are some typical tasks that may be performed using the *LexisNexis CD* application:

• Locate information using the table of contents, much as you would in a printed book

• Formulate and execute a query for specific material or for material related to a given topic

• Navigate and read content

• Print material

• Export content for later use

**Starting the Program**

Regardless of the Windows® operating system you are using, you start the *LexisNexis CD* application the same way.

› To start the *LexisNexis CD* application

1 Open the **Start** menu in one of the following manners:
   • Press the **WINDOWS LOGO** key.
   
   **OR**
• Press CTRL + ESC.

**OR**

• Activate the Start button, located on the taskbar in the lower-left corner of your Windows desktop.

**Tip:** If you chose to place a program icon on your desktop during the installation process, you can also initiate program launch by activating the icon then skipping to the bulleted items following step 4, below.

2 On the Start menu choose Programs.

3 On the Programs menu choose LexisNexis CD on Folio 4.

4 On the LexisNexis CD on Folio 4 menu choose LexisNexis CD on Folio 4 (or, for network users, either LexisNexis CD on Folio 4 Client or LexisNexis CD on Folio 4 Admin).

• If you are a new user, a message opens, alerting you that the LexisNexis CD program can be run in accessibility mode for users who are visually impaired. Proceed to step 5.

**OR**

• If you are an existing user, the LexisNexis CD application launches to display the Content Selector, from which you may open the desired publication(s) and begin working in the program (see “To open a publication upon first launching the program,” on page 8) without completing the remaining steps of this procedure.

5 Indicate whether you want to run the program in accessibility mode, choosing Yes to do so or No to instead run the program in standard mode.

**Note:** You can change operating mode at any time, if desired. For related instructions, please see “Using the Program in Accessibility Mode,” on page 10.

The LexisNexis CD application launches to display the Content Selector, from which you may open the desired publication(s) and begin working in the program (see “To open a publication upon first launching the program,” on page 8).
Opening a Publication

Immediately upon launching the LexisNexis CD application, the Content Selector is displayed. From this window, you may open one or more publications and begin working in the application. You can also access the Content Selector and open additional publications from within the application.

To open a publication upon first launching the program

1. From the Library drop-down list in the Content Selector, choose the library containing the publication(s) that you want to open.
   The chosen library is displayed in the Library field, and the publications in that library are listed in the corresponding area of the Content Selector.
2. Press the Tab key until the focus is on the publication list.
3. Select one or more publications by pressing the Down Arrow key until the focus is placed on the desired publication, then pressing the Spacebar.

   IMPORTANT! If you are accessing your data via CD and have just one CD-ROM drive, you can open only publications residing on the CD that is currently in the drive. You can avoid this problem by copying your data to a local or network drive via Data Manager (see “Copying a Library from CD,” on page 102).
   You can determine whether a publication is available by the text preceding the publication title.
   To update the publication list to reflect current availability after switching CDs, activate the Refresh button.
   Note: If you want to see a list of those publications to which you do not currently subscribe, put the focus on the Display Owned publications area the press the Down Arrow or Right Arrow key to enable the Display Unowned Publications option. Note, however, that you will not be able to open and view content for non-licensed publications.
4. Open the selected publication(s) in one of the following manners:
To open a publication from within the program

1. From the main window, open the Content Selector in one of the following manners:
   - Press \texttt{SHIFT} + \texttt{S}.
   \textbf{OR}
   - Press \texttt{ALT} + \texttt{X} to activate the \textit{LexisNexis} menu then choose Content Selector.

2. In the Content Selector, activate the drop-down arrow beside the Library field and choose the library containing the publication(s) that you want to open.

   The chosen library is displayed in the Library field, and the publications in that library are listed in the corresponding area of the Content Selector.

3. Press the \texttt{TAB} key until the focus is on the publication list.

4. Select one or more publications by pressing the \texttt{DOWN ARROW} key until the focus is placed on the desired publication, then pressing the \texttt{SPACEBAR}.

\textbf{IMPORTANT!} If you are accessing your data via CD and have just one CD-ROM drive, you can open only publications residing on the CD that is currently in the drive. You can avoid this problem by copying your data to a local or network drive via Data Manager (see “Copying a Library from CD,” on page 102). You can determine whether a publication is available by the text preceding the publication title.

To update the publication list to reflect current availability after switching CDs, activate the \textit{Refresh} button.
5 Open the selected publication(s) in one of the following manners:
   - Press ENTER.
   - OR
   - Activate the Open button.

Using the Program in Accessibility Mode

For those users who are visually impaired, the LexisNexis CD application can be run in accessibility mode. Setting the program to run in this mode accommodates screen-reader software usage to the greatest extent possible.

Accessibility mode can be enabled when installing the program as well as at anytime after program installation.

**IMPORTANT!** Changing between operation modes after the program has been installed requires a program restart and will result in the resetting of program preferences to their default values. If you previously adjusted your program preferences and want to continue using those preferences, you will have to again manually adjust them accordingly.

In accessibility mode, you can navigate and manipulate the program interface and open program menus, from which you can then activate program features, using only the keyboard, as outlined in Table 2-1, on page 11.

**Note:** You must have a publication open in order to access most program feature (“Opening a Publication,” on page 8).
To enable or disable accessibility mode post program installation

1. Press **ALT + X** to activate the [LexisNexis](#) menu then choose Accessibility Mode.
   The program displays a message indicating that switching between operating modes requires program to close and prompting you to confirm your desire to switch modes.
2. Choose **Yes** in the message.
   The message and the program close.
3. Relaunch the program to begin working in the chosen mode.

Table 2-1 Keyboard Navigation Summary for Basic Program Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Keyboard Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the File menu.</td>
<td><strong>ALT + F</strong></td>
</tr>
<tr>
<td>Open the Edit menu.</td>
<td><strong>ALT + E</strong></td>
</tr>
<tr>
<td>Open the View menu.</td>
<td><strong>ALT + V</strong></td>
</tr>
<tr>
<td>Open the Navigate menu</td>
<td><strong>ALT + N</strong></td>
</tr>
<tr>
<td>Open the Search menu.</td>
<td><strong>ALT + S</strong></td>
</tr>
<tr>
<td>Open the Layout menu.</td>
<td><strong>ALT + L</strong></td>
</tr>
<tr>
<td>Open the Tools menu.</td>
<td><strong>ALT + T</strong></td>
</tr>
<tr>
<td>Open the Window menu.</td>
<td><strong>ALT + W</strong></td>
</tr>
<tr>
<td>Open the LexisNexis menu.</td>
<td><strong>ALT + X</strong></td>
</tr>
<tr>
<td>Open the Help menu.</td>
<td><strong>ALT + H</strong></td>
</tr>
<tr>
<td>Move the focus from one pane displayed in the main window to the next.</td>
<td><strong>F8</strong></td>
</tr>
</tbody>
</table>
Understanding the Main Window

The *LexisNexis CD* main window is the window that appears when you first open a publication. The appearance of the various areas of the window may subsequently change depending on the task you are performing. The main window allows for display of a number of panes, or major divisions, within which various types of information are displayed, as follows:

- **Contents pane** — Displays a hierarchical representation of content for the active publication. The Contents pane can be used to peruse publication content (see “Browsing Publication Components,” on page 17); display a given portion of publication content for viewing (see “Navigating and Viewing Publication Content,” on page 18); limit content displayed for viewing (see “Limiting Content Displayed for Viewing,” on page 19); narrow a search (see “Searching Selected Divisions of the Active Publication,” on page 49); and limit content to be exported (see “To export content of selected divisions in the active publication,” on page 83).

- **Reference pane** — Displays source information (e.g., volume, chapter, and section) for the content currently displayed in the Document pane. (See “Understanding the Document and Reference Panes,” on page 24, for more information.)

### Table 2-1 Keyboard Navigation Summary for Basic Program Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Keyboard Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change view (that is, which panes are displayed in the main window).</td>
<td>F7</td>
</tr>
<tr>
<td>Move the focus between tab rows in dialog boxes.</td>
<td>UP ARROW or DOWN ARROW</td>
</tr>
<tr>
<td>Move the focus between tabs within rows in dialog boxes.</td>
<td>RIGHT ARROW or LEFT ARROW</td>
</tr>
<tr>
<td>Move the focus between options in dialog boxes.</td>
<td>TAB</td>
</tr>
<tr>
<td>Enable options in dialog boxes.</td>
<td>SPACEBAR</td>
</tr>
</tbody>
</table>
• **Document pane** — Displays publication content. (See “Understanding the Document and Reference Panes,” on page 24, for more information.)

• **Hit List pane** — After a search is run, displays a list of hits grouped by record. (See “Viewing Search Results Using the Hit List,” on page 66, for more information.)

The panes of the main window can be displayed in various combinations, or views, as follows:

• **All view** — Displays all panes; useful for viewing publication content and search results in the broadest possible context.

• **Search view** — Displays the Document, Reference, and Hit List panes; useful for viewing search results in a broader context than that afforded by the Hit List only view but without the additional context provided by the table of contents.

• **Browse view** — Displays the Document, Reference, and Contents panes; useful for scanning of publication content and/or search results.

• **Document view** — Displays the Document and Reference panes; useful for detailed review of publication content.

• **Contents view** — Displays only the Contents pane; useful for high-level browsing of publication content and/or search results.

• **Hit List view** — Displays only the Hit List pane; useful for high-level browsing of search results.

The main window also features a menu bar, from which you may access commands to initiate various tasks, including navigating search results.

---

**Note:** Available menus and commands may vary depending on program mode (i.e., the most recent task performed) and interface mode (the active part of the interface). Instructions for executing specific commands are included within the discussion of corresponding tasks. For a more detailed discussion of the menus themselves, refer to “Understanding the Menus,” on page 117.
Setting Program Preferences

To address varied user preferences, the *LexisNexis CD* application allows for customizing certain aspects of the program.

Some preferences relate primarily to the interface, or how the program “looks.” Examples include font used to display certain content, and menu components. Instructions for setting some basic interface-related preferences are provided under “Customizing the Interface,” beginning on page 135.

Other preferences relate primarily to functionality, or how the program works. Key functionality-related preferences are outlined in Table 2-2, which also provides information on finding corresponding descriptions and instructions in this guide.

Table 2-2 Summary of Key Functionality-Related Preferences

<table>
<thead>
<tr>
<th>Preference</th>
<th>Find related description and instructions here</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display in the table of contents the titles of only those searched levels having records with hits</td>
<td>“Viewing Search Results Using the Table of Contents,” on page 67</td>
</tr>
<tr>
<td>Automatically synchronize the table of contents to the location in publication content as currently displayed in the Document pane</td>
<td>“Synchronizing the Table of Contents,” on page 20</td>
</tr>
<tr>
<td>Automatically synchronize the Document pane to your location in the table of contents</td>
<td>“Synchronizing the Document Pane,” on page 27</td>
</tr>
<tr>
<td>Limit the amount of content to display in the Document pane after a search</td>
<td>“Limiting Content Displayed After a Search,” on page 70</td>
</tr>
</tbody>
</table>

Quitting the Program

When you finish your session, you can quit the *LexisNexis CD* application as follows:

Press **ALT + F** to activate the **File** menu then choose **Exit**.
Chapter 3  Working with the Table of Contents

Working with the table of contents in the LexisNexis® CD application involves the following:
• Displaying the table of contents
• Understanding uses for the table of contents
• Understanding table of contents hierarchy
• Browsing publication components
• Navigating and viewing publication content
• Limiting content displayed for viewing
• Synchronizing the table of contents

This chapter outlines each of these topics and, where applicable, provides instructions for performing the given task.

Displaying the Table of Contents

Because the LexisNexis CD application allows you to choose at any time between several view settings, the table of contents may not always be displayed. To view the table of contents, you must elect either the Contents, the All, or the Browse view. In Contents view, the table of contents occupies the entire window; in the All or Browse view, the table of contents appears in the Contents pane on the left-hand side of the window, beside the Document and Reference panes.

† To display the full-window table of contents
  Press CTRL + SHIFT + C.
  OR
  Press F7 until Contents view is activated.
  OR
  Press ALT + N to open the Navigate menu then choose Next View or Prev View until Contents view is activated.

† To display the partial-window table of contents
  Press F7 until All or Browse view is activated.
OR

Press ALT + N to open the Navigate menu then choose Next View or Prev View until All or Browse view is activated.
The table of contents is displayed in the left-hand pane of the main window.

Understanding Table of Contents Hierarchy

In most printed books, content is divided into a hierarchy, or levels. For example, a book may contain at the highest level multiple volumes. Those volumes may, in turn, contain multiple parts, which, in turn, contain multiple chapters, and so on. Likewise, content in the LexisNexis CD application is divided into a hierarchy, and this hierarchy is reflected in the table of contents.

The program uses increasing degrees of indentation to differentiate increasing levels of detail in the table of contents; thus, all entries of a given level (e.g., chapter or court division) will be indented to the same degree, and all sub-entries of a given level beneath those entries (e.g., section or decision year) will be further indented to the same degree. You can expand entries in the table of contents to view an increasing level of detail or collapse entries to facilitate the viewing of higher-level items (see “Browsing Publication Components,” on page 17).

Understanding Uses for the Table of Contents

You can use the table of contents to browse publication components (see related topic on page 17), to navigate and view publication content (see related topic on page 18), to print only certain divisions of publication content (see related topic on page 74), and to limit the publication content displayed for viewing (see related topic on page 19).

When you run a search, you can also use the table of contents to do the following:

• Display the entries of only those searched levels containing records with hits

Note: For details on setting table of contents preferences related to displaying search results, see “Viewing Search Results Using the Table of Contents,” on page 67.)
• Limit the search to only certain levels of a publication (see “Searching Selected Divisions of the Active Publication,” on page 49)

You can also use the table of contents to help keep track of your location within a publication while you are viewing publication content. By default, the *LexisNexis CD* application is set to automatically synchronize the table of contents to your current location in publication content, highlighting the corresponding entry in the table of contents. (For further details, see “Synchronizing the Table of Contents,” on page 20.)

**Browsing Publication Components**

To facilitate browsing of publication components, the *LexisNexis CD* application initially shows only the top-level entries. These entries are all collapsed, with the detailed lists of their contents hidden. You can expand entries to view an increasing level of detail or collapse entries to facilitate the viewing of higher-level items.

You can tell whether a particular entry in the table of contents is collapsed or expanded by checking the icon that appears to its left. A \( \rightarrow \) indicates that the associated entry is collapsed to hide details, whereas a \( \Rightarrow \) indicates that the entry is fully expanded, with all details displayed.

<table>
<thead>
<tr>
<th>Note: In accessibility mode, screen-reader software translates the plus and minus icons in the table of contents as “open” and “closed,” respectively.</th>
</tr>
</thead>
</table>

- **To expand a level in the table of contents to the immediate sublevel**
  
  Place the focus on the desired level, then press the + key.

  **OR**

  Place the focus on the desired level then press ALT + V to open the View menu and choose **Expand One Level**. The level expands, revealing all headings at the immediate sub-level.

- **To fully expand a level in the table of contents**

  1. Place the focus on the desired level.
18 Working with the Table of Contents

2 Press ALT + V to open the View menu then choose Expand Branch.
The level fully expands, revealing all sublevels.

- To collapse a level in the table of contents
  Place the focus on the desired level, then press the - key.
  OR
  Place the focus on the desired level then press ALT + V to open the View menu and choose Collapse Branch.
  The level collapses, hiding all sublevels.

- To fully expand the table of contents
  1 Place the focus anywhere within the Contents pane.
  2 Press ALT + V to open the View menu then choose Expand All.
  The table of contents fully expands, revealing all levels.

- To fully collapse the table of contents
  1 Place the focus anywhere within the Contents pane.
  2 Press ALT + V to open the View menu then choose Expand to Level.
  The Levels dialog box opens.
  3 In the list of levels, choose the item corresponding to the uppermost level in the given publication (e.g., Part).
  4 Activate the OK button.
  The table of contents fully collapses, displaying entries for only the uppermost level.

Navigating and Viewing Publication Content

If you are looking for a particular topic within a publication, you can use the table of contents hierarchy to find it. Once the corresponding entry appears in the Contents pane, you can easily navigate to that portion of the publication and view the corresponding content.
To navigate and view publication content from the table of contents

1. Expand or collapse the table of contents hierarchy until the entry for the desired content is displayed.
2. Display the desired content in the Document pane by placing the focus on the corresponding entry, then pressing **CTRL + ENTER**.

A box appears around the entry in the table of contents, the corresponding content is displayed in the Document pane, and the Reference pane displays the access path (source information as represented in the table of contents hierarchy) for the currently displayed content.

Note: See “Understanding the Document and Reference Panes,” on page 24, for more information about these elements.

Limiting Content Displayed for Viewing

When you open a publication, the *LexisNexis CD* application by default displays in the Document pane complete content for that publication. At times, however, you may want to limit the amount of content displayed to facilitate viewing of relevant material.

**To limit content displayed for viewing**

1. Expand or collapse the table of contents hierarchy to display the heading(s) for the desired content.
2. Select the desired content by placing the focus on the corresponding heading then pressing the **SPACEBAR**.
Place the focus anywhere in the Document pane, then press *ALT + V* to open the View menu and choose **Show Check Boxes**. The Document pane is updated to display only the content corresponding to your selection(s) in the table of contents.

**Tip:** If check boxes are not currently displayed in the table of contents, do one of the following:

- To display check boxes only for the current publication and session, press *ALT + V* to open the View menu then choose **Show Check Boxes**.
- To display check boxes for all publications and sessions, press *ALT + T* to open the Tools menu then choose **Options**. In the Options dialog box, activate the Contents tab then place the focus on the **Checked Branches** option and press the SPACE-BAR until a checkmark appears. Finally, activate the OK button to close the Options dialog box.

3 Place the focus anywhere in the Document pane, then press *ALT + V* to open the View menu and choose **Checked Branches**. The Document pane is updated to display only the content corresponding to your selection(s) in the table of contents.

**Tip:** If you subsequently deselect all content in the table of contents, nothing will be displayed in the Document pane. To again display content, you must either select one or more levels in the table of contents or elect a different display setting (i.e., All Records, Records with Hits, or Tagged Records).

### Synchronizing the Table of Contents

As a tool for helping you keep track of your location within a publication, the *LexisNexis CD* application is set by default to automatically synchronize the table of contents. As you peruse content in the Document pane, the table of contents is updated to display a box around the entry corresponding to your location in the publication.

**Note:** If the table of contents is collapsed to the uppermost levels and you are viewing content at a sub-level, the entry for the uppermost level containing that content will be highlighted in the table of contents. If the table of contents is expanded to the sub-level corresponding to the content you are viewing, the entry for that sub-level will be highlighted in the table of contents.
If you prefer, you can disable the automatic synchronization feature and instead manually synchronize the table of contents whenever desired.

**Note:** The *Headings with Hits* option takes precedence over automatic synchronization of the table of contents. Thus, if after running a search, you navigate to a record having no hits, the table of contents will not synchronize to your current location. To re-enable automatic synchronization in such an instance, either disable the *Headings with Hits* option (see “To enable or disable display of only headings with hits in the table of contents,” on page 67) or clear the search (see “Clearing a Search,” on page 57).

- **To enable or disable automatic synchronization of the table of contents**
  1. Press **ALT + T** to open the *Tools* menu then choose *Options*. The Options dialog box opens.
  2. Activate the *Contents* tab.

    **Tip:** To move from tab to tab within the same row of tabs in the Options dialog box, press the **RIGHT ARROW** or **LEFT ARROW** key; to move between tab rows, press the **UP ARROW** or **DOWN ARROW** key.

  3. Enable or disable automatic synchronization of the table of contents as follows:
     - To enable this option (i.e., have the table of contents automatically synchronize to reflect the location in publication content as currently displayed in the Document pane), place the focus on the *Synchronize to document* option then press the **SPACEBAR** until a checkmark appears in the check box.
     
     **OR**
     - To disable this option, place the focus on the *Synchronize to document* option then press the **SPACEBAR** until the checkmark is cleared from the check box.
  4. Activate the **OK** button.

    **Tip:** Alternatively, choose **Cancel** to exit the Options dialog box without making any changes.
Your preference for automatic synchronization of the table of contents is set, and the Options dialog box closes.

- **To manually synchronize the table of contents**

  Press **ALT + V** to open the **View** menu then choose **Synchronize Contents**.

  The table of contents is synchronized to reflect your present location in publication content as displayed in the Document pane.

  **Note:** If the table of contents is collapsed to the uppermost levels and you are viewing content at a sub-level, the entry of the uppermost level containing that content will be highlighted in the table of contents. If the table of contents is expanded to the sub-level corresponding to the content you are viewing, the entry of that sub-level will be highlighted in the table of contents.
Chapter 4  Viewing Content

Viewing content in the LexisNexis® CD application involves the following:

- Displaying the Document and Reference panes
- Understanding the Document and Reference panes
- Understanding content-navigation aids
- Reading footnotes
- Reading supplements
- Synchronizing the Document pane

This chapter outlines each of these topics and, where applicable, provides instructions for performing the given task.

Displaying the Document and Reference Panes

Because the LexisNexis CD application allows you to choose at any time between several view settings, the Document and Reference panes may not always be displayed. To view the Document and Reference panes, you must elect either the All, the Search, the Browse, or the Document view.

- To display the Document and Reference panes
  - Press CTRL + SHIFT + D to activate Document view.
  - OR
    - Press F7 until All, Search, Browse, or Document view is activated.
  - OR
    - Press ALT + N to open the Navigate menu then choose Next View or Prev View until Document, All, Search, or Browse view is activated.
Understanding the Document and Reference Panes

When you open a publication in the LexisNexis CD application, the program displays the content in the Document pane. Hierarchical source information for the content (e.g., volume, chapter, and section) is displayed in the Reference pane immediately above the Document pane.

**Note:** If complete source information is not visible in the Reference pane and you are running the program in non-accessibility mode, simply resize the pane. To do so, position your mouse pointer over the separator line until the double-headed arrow is displayed. Then, press and hold the primary mouse button, drag the separator line until the pane is the desired size, and release the mouse button. For those users running the program in accessibility mode, note that panes cannot be resized via the keyboard.

**Tip:** Each component in the Reference pane serves as a direct link to the corresponding element in publication content. Selecting the desired component in the Reference pane then pressing ENTER the component causes the focus in the Document pane to move to the beginning of the corresponding element in publication content.

Understanding Content-Navigation Aids

The LexisNexis CD application offers a number of navigation aids to help you view content. The available navigation aids are described in the following sections.

**Arrow Keys**

Use the Up Arrow and Down Arrow keys to move through publication content, the table of contents, or the hit list.
Text-PROPER Links

Text-proper links let you jump directly from one location to another in the text proper of either the currently displayed publication or another publication.

**Tip:** The presence of links is indicated by a change in font attributes as identified by screen-reader software. The most common font attributes used for links are as follows:

- Bold blue
- Underlined blue on white

Note, however, that non-linking text may also make use of these font attributes. To determine whether text carrying these font attributes constitutes a link, first position your cursor at the beginning of the suspected link, next press **CTRL + ENTER**, then press the **DOWN ARROW** key.

Other font attributes used less commonly for links are as follows:

- Italic underlined blue
- Italic blue
- Red on white

**Note:** The LexisNexis CD application uses two “specialized” links for footnotes and supplements. These links function somewhat differently than regular links. See “Footnote Links,” on page 26, and “Supplement Links,” on page 26, for further information.

- **To link within or between publications**

  Activate the link in publication content by positioning your cursor at the beginning of the link then pressing **CTRL + ENTER**.

  Your view jumps from the current location to the destination referenced by the link.

**IMPORTANT!** To return to the location from which you linked, either press F6 or press **ALT + N** to open the **Navigate** menu then choose **Go Back**.
Table of Contents

You can move from one area in a publication to another via the table of contents. Refer to “Navigating and Viewing Publication Content,” on page 18, for further details.

Footnote Links

Footnotes provide additional information relevant to the document you are viewing. The existence of a footnote is typically denoted in text by a superscript, underlined, colored-number or asterisk link. Footnotes themselves generally appear at the end of the content segment to which they refer.

- **To jump to a footnote**
  
  In the document text, activate the footnote number or asterisk by positioning your cursor just before the footnote number or asterisk, then pressing **CTRL + ENTER**. The footnote text is displayed at the top of the Document pane.

- **To return from a footnote to its corresponding link location in text**
  
  Activate the reference number preceding the footnote text by positioning your cursor just before the reference number then pressing **CTRL + ENTER**.
  
  You are returned to the location of the footnote link in publication content.

Supplement Links

When a document has been updated by a supplement, supplement links will appear in the document as colored, underlined text reading either “[Go to Supp]” or [Current Developments].” Unlike numbered footnotes, supplement text generally does not appear at the end of the corresponding document but instead constitutes a separate document (and is reflected in the table of contents as such).

- **To view a supplement**
  
  Activate the [Go to Supp] or [Current Developments] link in text or the supplement title in the table of contents, as applicable:
To activate the [Go to Supp] or [Current Developments] link in text, position your cursor at the beginning of the link then press CTRL + ENTER.

**OR**

To activate the supplement title in the table of contents, select the title then press CTRL + ENTER.

The text of the supplement appears in the Document pane.

- **To return from a supplement to its corresponding document**

  Activate the [Go to Main] link by positioning your cursor just before the link then pressing CTRL + ENTER.

  You are returned to the supplement link location in the text of the corresponding document.

### Synchronizing the Document Pane

As a tool for helping you find relevant information quickly, the LexisNexis CD application offers the option of automatically synchronizing the Document pane. When this option is enabled and you browse the table of contents, the view in the Document pane scrolls to the location in publication content corresponding to your location in the table of contents.

- **To enable or disable automatic synchronization of the Document pane**

  1. Press ALT + T to open the Tools menu then choose Options.

     The Options dialog box opens.


     **Tip:** To move from tab to tab within the same row of tabs in the Options dialog box, press the RIGHT ARROW or LEFT ARROW key; to move between tab rows, press the UP ARROW or DOWN ARROW key.

  3. Enable or disable automatic synchronization of the Document pane as follows:

     - To enable this option (i.e., have the Document pane automatically synchronize to reflect your location in the table of
contents), place the focus on the *Synchronize to contents* option then press the SPACEBAR until a checkmark appears in the check box.

**OR**

- To disable this option, place the focus on the *Synchronize to contents* option then press the SPACEBAR until the checkmark is cleared from the check box.

4 Activate the **OK** button.

**Tip:** Alternatively, choose **Cancel** to exit the Options dialog box without making any changes.

Your preference for automatic synchronization of the Document pane is set, and the Options dialog box closes.
Chapter 5  Understanding Search Mechanisms

The LexisNexis® CD application offers three basic mechanisms for performing searches:
• Advanced Query window
• Query templates
• Query dialog box
These mechanisms are outlined in greater detail in the following sections.

Advanced Query Window

The Advanced Query window is always accessible by pressing the F2 key.

This mechanism allows you to specify various types of queries, alone or in combination. Thus, using the Advanced Query window, you can search for one or more of the following:
• A specific word
• Variations on a given word
• Words in relationship to other words
• Words as an exact string (i.e., a phrase)
• Multiple words within a given proximity of each other
(See Chapter 6, “Formulating a Query,” for information on crafting search criteria.)

When you run your search, the LexisNexis CD application by default searches for your specified query in all content contained either in the active publication or in all open publications, depending on the button that you activate to execute the search. Note, however, that the program offers several options for refining the scope of a search (see Chapter 7, “Changing Search Range,” for details).

Once your search is complete, you can edit the query and run a new search, re-run the search against updated case content on the lexis.com® service (assuming the searched publication was a case col-
To run a search using the Advanced Query window

1. Open one or more publications that you want to search. (For instructions on opening a publication, see “Opening a Publication,” on page 8.)

   **Tip:** If you are accessing your data via CD and you have a multiple-CD library but only a single CD-ROM drive, you can search only the CD that is currently in the drive. You can avoid this problem by copying your data to a local or network drive via Data Manager (see “Copying a Library from CD,” on page 102).

2. Open the Advanced Query window in one of the following manners:
   - Press the F2 key.
   - OR
   - Press ALT + S to open the Search menu then choose Advanced Query.

3. In the **Query For** field, type your query.
   The Word Wheel scrolls to highlight the word most closely matching your input.

   **Note:** For additional information, see Chapter 6, “Formulating a Query,” and “Building a Query from Words in the Active Infobase,” on page 44. Note that you can also frame a query so that only certain structural elements within the publication will be searched. See “Searching a Structural Element (Scope) in One or All Open Publications,” on page 51, for further details.

4. Apply your search as appropriate:
Understanding Search Mechanisms

- If you are searching only the active publication, activate the OK button.

  OR

- If you are searching all open publications, activate the Apply to All button.

The Advanced Query window closes, and the search results are displayed in the Contents, Document, and Hit List panes. (For further information, see “Viewing Search Results,” beginning on page 65.)

**Note:** If you have enabled the Headings with Hits option, the table of contents is updated to list only those searched levels containing records with hits. (See “Viewing Search Results Using the Table of Contents,” on page 67, for more information.)

### Query Templates

The *LexisNexis CD* application offers a number of query templates, allowing you to craft searches focusing on specific structural elements (e.g., levels, fields, and groups) within given types of content (e.g., analysis, code, and case). In this way, you can easily hone a search without having to know the underlying syntax.

Available query templates vary depending on the publication. (See Appendix B, “Working with Query Templates,” for detailed information on some of the most commonly provided query templates.)

The query templates available for a given publication are listed at the bottom of the Search menu, from which they can be directly accessed. Query templates allow you to specify the following types of queries, either alone or in combination:

- A specific word
- Variations on a given word
- Words in relationship to other words
- Words as an exact string (i.e., a phrase)
- Multiple words within a given proximity of each other

(See Chapter 6, “Formulating a Query,” for information on crafting search criteria.)
Once you execute a search using a query template, the program searches for your specified criteria only in those records of the given content type (e.g., treatise). Note that the program also offers several options for further refining the scope of a search (see Chapter 7, “Changing Search Range”).

Once your search is complete, you can edit the query and run a new search, re-run the search against updated case content on the lexis.com® service (assuming the searched publication was a case collection), or clear the search. (See Chapter 8, “Extending Search Functionality,” for more information.)

- **To perform a search using a query template**

  **Tip:** If you are accessing your data via CD or DVD and you have a multiple-disc library but only a single CD-ROM or DVD drive, you can search only the disc that is currently in the drive. You can avoid this problem by copying your data to a local or network drive via Data Manager (see “Copying a Library from CD,” on page 102).

  1. Open the publication that you want to search (see “Opening a Publication,” on page 8).

     **Tip:** You can elect to limit your search to only selected divisions of the publication. To do so, you must indicate those divisions in the table of contents before opening the query template. For further details, see “Searching Selected Divisions of the Active Publication,” on page 49.

  2. Open the desired query template by pressing **Alt + S** to open the Search menu and choosing the corresponding name from the bottom of the menu. (See Appendix B, “Working with Query Templates,” for illustrations of sample query templates.)

  3. In the desired query input field(s), type your query.

     The Word Wheel scrolls to highlight the word most closely matching your input.
Apply your search by activating the OK button.
The query template closes, and the search results are displayed in the Contents, Document, and Hit List panes. (For further information, see “Viewing Search Results,” beginning on page 65.)

**Note:** If you have enabled the Headings with Hits option, the table of contents is updated to list only those searched levels containing records with hits. (See “Viewing Search Results Using the Table of Contents,” on page 67, for more information.)

---

### Query Dialog Box

The Query dialog box is accessed either by activating the Search menu and choosing Query or pressing the F3 key.

**IMPORTANT!** Unlike the Advanced Query window and the query templates, which use Boolean-logic in executing a search, the Query dialog uses natural language. This has implications with regard to query formulation. For details, see “Understanding Natural Language Searching,” on page 45, and “Query Interpretation in Natural Language Searching,” on page 46.

This mechanism allows you to specify various types of queries, alone or in combination. Thus, using the Query dialog box, you can search for one or more of the following:

- A specific word
- Variations on a given word
- Words in relationship to other words
- Words as an exact string (i.e., a phrase)
When you run a search using the Query dialog box, the LexisNexis CD application by default searches for your specified query in all content contained in the active publication. Note, however, that you may narrow a search to selected divisions of the publication by indicating those divisions in the table of contents. (For further details, see “Searching Selected Divisions of the Active Publication,” on page 49).

Once your search is complete, you can edit the query and run a new search, re-run the search against updated case content on the lexis.com® service (assuming the searched publication was a case collection), or clear the search. (See Chapter 8, “Extending Search Functionality,” for more information.)

**Note:** The Query dialog box does not allow for ordered or unordered proximity searching.

**IMPORTANT!** The search results obtained when using the Query dialog box will differ from those obtained when using the other search mechanisms (i.e., the Advanced Query window and the query templates). For details, see “Search Results Compilation in Natural Language Searching,” on page 47.

> To run a search using the Query dialog box

**Tip:** If you are accessing your data via CD or DVD and you have a multiple-disc library but only a single CD-ROM or DVD drive, you can search only the disc that is currently in the drive. You can avoid this problem by copying your data to a local or network drive via Data Manager (see “Copying a Library from CD,” on page 102).

1. Open the publication that you want to search. (For instructions on opening a publication, see “Opening a Publication,” on page 8.)

**Tip:** You can elect to limit your search to only selected divisions of the publication. To do so, you must indicate those divisions in the table of contents before opening the Query dialog box. For further details, see “Searching Selected Divisions of the Active Publication,” on page 49.

2. Open the Query dialog box in one of the following manners:
• Press the F3 key.

**OR**

• Press ALT + S to open the Search menu then choose Query.

3 In the Query For field, type your query.

**Note:** For general information, see “Formulating a Query,” beginning on page 37; for information specific to formulating a query for use with the Query dialog box, see “Query Interpretation in Natural Language Searching,” on page 46.

4 Apply your search by activating the OK button.

The Query dialog box closes, and the search results are displayed in the Contents, Document, and Hit List panes. (For further information, see “Viewing Search Results,” beginning on page 65.)

**Note:** If you have enabled the Headings with Hits option, the table of contents is updated to list only those searched levels containing records with hits. (See “Viewing Search Results Using the Table of Contents,” on page 67, for more information.)
Chapter 6 Formulating a Query

The LexisNexis® CD application enables you to formulate queries of various forms. Specifically, you can craft a query for any of the following, alone or in combination:

- A specific word
- Variations of a word (using wildcards)
- Words in relationship to other words (using connectors)
- Words as an exact string (i.e., a phrase)
- Multiple words within a given proximity of each other

**Note:** Regardless of the type of query, you can craft it in such a way so as to apply the query to only certain structural elements within a publication, (assuming you are using either the Advanced Query window or a query template to run your search). For details, see "To search a structural element within one or all open publications," on page 52.

**Tip:** Assuming you are using either the Advanced Query window or a query template to craft your query, the LexisNexis CD application provides ready access to a list of words in the active infobase, allowing you to maximize the efficiency of your query. (For details, see “Building a Query from Words in the Active Infobase,” on page 44.)

**IMPORTANT!** When you use the Query dialog box, the program uses natural language in executing your search. This has implications with regard to interpreting a query and compiling search results. For details, see “Understanding Natural Language Searching,” on page 45.

Searching for a Specific Word

The simplest form of query is a single word. When you enter a single word as the criterion for a search, the LexisNexis CD application looks for that exact word in publication content.
Searching for Variations of a Word

In certain situations, you may want to search for discussions of a given topic, but you may not know the exact word form used to refer to that topic in the content that you are searching. For example, a discussion on the topic of notifications, may reference the variant forms notification, notify, notifies, or notified without referencing notifications.

To address such situations, the LexisNexis CD application supports searching for word variations via the use of wildcard characters.

The program supports two wildcard characters: the question mark (?) and the asterisk (*). Table 6-1 describes each wildcard character and provides examples and corresponding results of searches using each.

Table 6-1  Wildcard Summary

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Symbol</th>
<th>Example/Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single character</td>
<td>?</td>
<td>Example: sm?th</td>
</tr>
<tr>
<td>wildcard</td>
<td></td>
<td>Result: This search finds smith and smyth, and any other variation where the third letter differs.</td>
</tr>
</tbody>
</table>

Tip: You can search for a specific word using any of the search mechanisms. Note, however, that when you use the Query dialog box to perform a search, the LexisNexis CD application will automatically look for records containing the exact word that you specified as well as variations on that word (see “Query Interpretation in Natural Language Searching,” on page 46, for more information).

Tip: All search mechanisms support the use of wildcards. Note that when you use the Query dialog box, however, the LexisNexis CD application will automatically look for records containing the exact word that you specify as well as certain variations on that word (see “Query Interpretation in Natural Language Searching,” on page 46, for more information).

Note also that you can use wildcards as part of a phrase search to slightly broaden the search [see “Searching for an Exact Word String (Phrase),” on page 42].
Searching for Words in Relationship

At times, you may want to craft a search to find discussions that reflect certain relationships among topics. For example, you may want to find material referencing both bankruptcy and liquidation. Or you may want to broaden a search to find discussions referencing bankruptcy or liquidation or both.

The LexisNexis CD application offers you great flexibility in defining relationships among multiple words entered as search criteria. Specifically, by inserting Boolean-based connectors between words, you can craft a search for any of the following:

- Two or more words (e.g., bankruptcy and liquidation)
- One word or another word or both words (e.g., bankruptcy or liquidation or both)
- One word or another word but not both words (e.g., bankruptcy or liquidation but not both)
- One word but not another word (e.g., bankruptcy not liquidation)
- Any combination of the above

Table 6-2 describes the Boolean-based connectors supported by the LexisNexis CD application and provides examples and corresponding results of searches using each. Note that when using a connector, you can type either the word, for example, and, or the corresponding symbol, for example, &.

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Symbol</th>
<th>Example/Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiple character wildcard</td>
<td>*</td>
<td><strong>Example:</strong> rectif*&lt;br&gt;<strong>Result:</strong> This search finds rectify, rectifying, rectifies, rectifier, and other variations.</td>
</tr>
</tbody>
</table>

Note: As implied in Table 6-2, if you enter as search criteria multiple words each separated by a space, the program will by default infer the and connector (i.e., return as search results only those records containing all entered words).
40 Formulating a Query

Tip: You can use the connectors outlined in Table 6-2 with the Advanced Query window as well as with all query templates. The Query dialog box, however, performs a natural language search, which requires the use of different connectors when searching for words in relationship. For further details, see "Query Interpretation in Natural Language Searching," on page 46.

### Table 6-2  Boolean-Based Connector Summary

<table>
<thead>
<tr>
<th>Connector</th>
<th>Symbol</th>
<th>Example/Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND</td>
<td>&amp;</td>
<td><strong>Examples:</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>husband and wife</td>
</tr>
<tr>
<td></td>
<td></td>
<td>husband &amp; wife</td>
</tr>
<tr>
<td></td>
<td></td>
<td>husband wife</td>
</tr>
<tr>
<td></td>
<td>space</td>
<td><strong>Result:</strong> This search finds only those records containing both the word husband and the word wife.</td>
</tr>
<tr>
<td>OR</td>
<td></td>
<td><strong>Examples:</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>child or offspring</td>
</tr>
<tr>
<td></td>
<td></td>
<td>child</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Result:</strong> This search finds those records containing the word child or the word offspring or both words.</td>
</tr>
<tr>
<td>XOR</td>
<td>~</td>
<td><strong>Examples:</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>anti-trust xor treble</td>
</tr>
<tr>
<td></td>
<td></td>
<td>anti-trust ~ treble</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Result:</strong> This search finds those records containing the word anti-trust or the word treble but not both words.</td>
</tr>
</tbody>
</table>
When you craft a query consisting of multiple words and connectors, the LexisNexis CD application by default applies each connector only to the word immediately following (in the case of the not connector) or the words immediately adjacent (in the case of the and, or, and xor connectors) and processes connectors in the following order:

1. Not
2. Or
3. Xor
4. And

As an example, consider the following query:

\[ \text{attorney and client not doctor and patient} \]

In response to this query, the program would first process the not connector, applying the connector to and eliminating as search results any record containing the word doctor. Next, the program would process the and connector, applying the connector to and including among the search results any record containing the words attorney, client, and patient. Thus, for this query, the program would return as search results those records containing the words attorney, client, and patient without containing the word doctor.

You may, however, want to instead find those records containing the words attorney and client but not the words doctor and patient. You can do so through the use of parentheses in the query, as follows:

\[ \text{attorney and client not (doctor and patient)} \]
In this way, you override the default connector application, instructing the program to apply the \textit{not} connector to the word \textit{patient} as well as to the word \textit{doctor}. For this query, then, the program will eliminate from the search results any record containing both words.

\textbf{Searching for an Exact Word String (Phrase)}

A phrase is an ordered collection of words that the \textit{LexisNexis CD} application interprets as a single unit. You would use a phrase as your search criteria when you want to find an exact match to a specific set of words in a specific order.

To craft a search in the form of a phrase, enclose the entered words in quotation marks (for example, “consumer bankruptcy” or “board of education”).

\begin{quote}
\textbf{IMPORTANT!} Note that unless you are using the Query dialog box (which automatically searches for variations on word form in all types of queries), this type of query is restrictive in nature in that you may not find relevant material if the wording of the material varies even \textit{slightly} from the entered query. However, you may use wildcards in phrase searches to slightly broaden the search. For example, a query of “consumer debt*” would return as search results all records containing the phrase “consumer debt”; “consumer debts”; “consumer debtor”; etc. (For further details on using wildcards, see “Searching for Variations of a Word,” on page 38.)
\end{quote}

\begin{quote}
\textbf{Tip:} Phrase searches are supported by all search mechanisms. Note, however, that the Query dialog box will automatically search for variations of each word entered as part of a phrase. See “Query Interpretation in Natural Language Searching,” on page 46, for more information.
\end{quote}

\textbf{Searching for Multiple Words within a Given Proximity of Each Other}

At times, you may want to home in on content containing specified words within a given distance of each other. For this reason, the \textit{LexisNexis CD} application supports both ordered and unordered proximity searches.
Ordered Proximity Searches

An ordered proximity search allows you to find records containing words that appear within a specified distance of each other and that appear in the order in which they are entered as search criteria. The syntax for an ordered proximity search is as follows:

“{whatever words you want to find}”/{within this number of words}

Thus, if you wanted to find material containing the words debtor and interest in that order and within 10 words of each other, you would enter the following as your query:

“debtor interest”/10

This query would return as search results only those records containing both words in the order entered and within 10 words of each other. If either word or both words do not appear, if both words do appear but do so farther apart than 10 words, or if both words do appear but in opposite order (i.e., interest then debtor), the record will not be returned as a search result.

Tip: You can perform ordered proximity searches using the Advanced Query window or any query template. The Query dialog box, however does not allow for ordered proximity searches.

Unordered Proximity Searches

An unordered proximity search allows you to find documents containing words that appear within a specified distance of each other regardless of the order in which they appear. The syntax for an unordered proximity search is as follows:

“{whatever words you want to find}”@{within this number of words}

Thus, if you wanted to find material containing the words debtor and interest within 10 words of each in any order, you would enter the following as your query:

“debtor interest”@10

This query would return as search results only those records containing both words within 10 words of each other. If either word or both words do not appear or if both words do appear but do so farther apart than 10 words, the record will not be returned as a search result.
Tip: You can perform unordered proximity searches using the Advanced Query window or any query template. The Query dialog box, however does not allow for unordered proximity searches.

Building a Query from Words in the Active Infobase

Assuming you are using either the Advanced Query window or a query template to craft your query, the LexisNexis CD application provides ready access to a list of all words in the active infobase. This feature, known as the Word Wheel, allows you to hone a query to maximize the efficiency of the related search.

As you type a word in the query input field, the Word Wheel scrolls to the word that most closely matches your input. You can also scroll through the Word Wheel until you find a word that you want to include in your query.

To build a query using words from the active infobase

1. Open the desired publication. (For instructions on opening a publication, see “Opening a Publication,” on page 8.)

   Tip: You can elect to limit your search to only selected divisions of the publication. To do so, you must indicate those divisions in the table of contents before opening the desired search mechanism. For further details, see “Searching Selected Divisions of the Active Publication,” on page 49.

2. Open the Advanced Query window or the desired query template, as applicable:
   - To open the Advanced Query window, press the F2 key or press ALT + S to open the Search menu then choose Advanced Query.
   - OR
   - To open a query template, press ALT + S to open the Search menu then choose the corresponding name from the bottom of the menu.
3 In the Word Wheel, press the **UP ARROW** or **DOWN ARROW** key to move the view upward or downward until you find a word for which you want to search.

**Tip:** You can also begin typing your query in the applicable query input field. When you do so, the Word Wheel scrolls to highlight the word most closely matching your input.

4 Insert the word from the Word Wheel into your query by putting the focus on the word in the Word Wheel then pressing **CTRL + ENTER**.

**Note:** If you insert multiple words from the Word Wheel into a query, the program will assume the **or** connector between the words. (For further information on Boolean-based connectors, see “Searching for Words in Relationship,” on page 39, and “Overriding Default Connector Application,” on page 41.)

5 Apply your search by activating the **OK** button. The given search mechanism closes, and the search results are displayed in the Contents, Document, and Hit List panes. (For further information, see “Viewing Search Results,” beginning on page 65.)

**Note:** If you have enabled the **Headings with Hits** option, the table of contents is updated to list only those searched levels containing records with hits. (See “Viewing Search Results Using the Table of Contents,” on page 67, for more information.)

**Understanding Natural Language Searching**

When you run a search in the *LexisNexis CD* application using either the Advanced Query window or a query template, the program uses standard Boolean-based logic in interpreting your query and does not otherwise filter search results. So, for example, if you were to enter a query of *husband and wife* the program would do as follows:

- Interpret the word **and** as an operator indicating the relationship between the terms *husband* and *wife* and therefore look for records
containing both the word *husband* and the word *wife* but otherwise ignore the word *and*.

- Return as search results all records containing both the word *husband* and the word *wife* in the order in which those records appear in publication content.

To address varying user needs, however, the program also allows for natural language searching via the Query dialog box. This type of search differs from the Boolean-based search described above in relation to both query interpretation and search results compilation.

### Query Interpretation in Natural Language Searching

Natural language searching has the following implications with regard to query interpretation:

- Whether your query consists of one or more words or a phrase, the program automatically looks for records containing the exact word form that you specify as well as variations on that word form. For example, if you enter *legislate*, the program looks for the word *legislate* as well as the words *legislates*, *legislated*, and *legisitating*.

**Note:** You can extend this default functionality through the use of wildcards (see “Searching for Variations of a Word,” on page 38).

- If you enter a Boolean-based connector (e.g., *and*) as part of your query, the program will interpret the connector as a query term, that is, will look for the connector along with the other entered terms. If you want to search for words in relationship, you must instead use natural language connectors, as outlined in Table 6-3.

**Note:** As indicated in Table 6-3, if you enter as search criteria multiple words each separated by a space, the program will by default infer the *or* connector (i.e., return as search results records containing one, multiple, or all entered words).
Search Results Compilation in Natural Language Searching

When you run a natural language search using the Query dialog box, the program returns as search results only up to 50 records containing hits. Furthermore, those records are ranked according to relevancy. Thus, entries in the hit list may not reflect the order of their occurrence in publication content.

In determining relevancy of a record containing hits, the program considers all of the following:

- The number of times the queried-for item(s) appear in the record, such that a record containing the queried-for item(s) 5 times will be considered more relevant than a record containing the queried-for item(s) 2 times.

### Table 6-3  Natural-Language Connector Summary

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Implied Connector</th>
<th>Example/Result</th>
</tr>
</thead>
</table>
| + (plus sign) | and               | Example: husband + wife  
Result: This query finds only those records containing both the word *husband* and the word *wife*. |
| Space        | or                | Example: child offspring  
Result: This search finds all records containing the word *child*, or the word *offspring*, or both words. |
| - (minus sign)| not               | Example: immigrant – alien  
Result: This search finds only those records containing the word *immigrant* without also containing the word *alien*. |
The number of times each item in a multiple-item query appears in overall publication content, such that a record containing even 1 occurrence of a less commonly found item will be considered more relevant than a record containing multiple occurrences of a more commonly found item.

The number of times the queried-for item(s) appear in the record relative to the length of the record, such that if two records contain the same number of occurrences of the queried-for item(s), the shorter record will be considered more relevant.

The number of queried-for items appearing in the record, such that a record containing 3 of 4 queried-for items will be considered more relevant than one containing only 2 of 4.
Chapter 7  Changing Search Range

When you run a query, the LexisNexis® CD application by default searches the active publication. If you are using the Query dialog box or the Advanced Query window, the program searches the entire active publication; if you are using a query template, the program searches only that content of the type specified by the template itself (e.g., treatise material).

The LexisNexis CD application does, however, provide for flexibility in defining search range. Specifically, you can instruct the program to search any of the following:

- Selected divisions of the active publication
- The entire contents of all open publications
- One of several defined structural elements (i.e., “scopes”) within one or all open publications
- The entire contents of all publications in a given directory on your computer

Searching Selected Divisions of the Active Publication

One way of refining search range is to limit the search to only certain divisions of the active publication. To do so, you must first select the desired division(s) via the table of contents.

Note: You can change search breadth in this manner using any of the search mechanisms (i.e., Advanced Query window, query templates, or Query dialog box).

To search selected portions of the active publication

1. Open the desired publication. (For instructions on opening a publication, see “Opening a Publication,” on page 8.)
2. In the Contents pane, expand the hierarchy until the publication divisions that you want to search are displayed.
3 Select the desired division(s) by placing the focus on the corresponding heading(s) then pressing the SPACEBAR.

**Note:** You must select the desired divisions before executing your search. Note that if you activate the check box of a division having one or more subdivisions, the subdivisions will automatically be selected, as indicated by the checkmark(s) inserted in the corresponding check box(es).

**Tip:** If check boxes are not currently displayed in the table of contents, do one of the following:

- To display check boxes only for the current publication and session, press ALT + V to open the View menu then choose Show Check Boxes.
- To display check boxes for all publications and sessions, press ALT + T to open the Tools menu then choose Options. In the Options dialog box, activate the Contents tab, then put the focus on the Checked Branches option and press the SPACEBAR until a checkmark appears. Finally, activate the OK button to close the Options dialog box.

4 Open the desired search mechanism:

- **To open the Query dialog box,** either press the F3 key or press ALT + S to open the Search menu then choose Query.
  
  **OR**

- **To open the Advanced Query window,** press the F2 key or press ALT + S to open the Search menu then choose Advanced Query.
  
  **OR**

- **To open a query template,** press ALT + S to open the Search menu then choose the corresponding name from the bottom of the menu.

5 In the applicable query input field, type your query.
Applying your search by activating the **OK** button.

The given search mechanism closes, and the search results are displayed in the Contents, Document, and Hit List panes. (For further information, see “Viewing Search Results,” beginning on page 65.)

---

**Note:** If you have enabled the *Headings with Hits* option, the table of contents is updated to list only those searched levels containing records with hits. (See “Viewing Search Results Using the Table of Contents,” on page 67, for more information.)

---

**Searching a Structural Element (Scope) in One or All Open Publications**

Another way of changing search range is to limit a search to a pre-defined structural element, or scope, within one or all open publications. While structural elements vary from publication to publication, some examples are as follows:

- **Level** — one of the hierarchical divisions within a publication, such as a section or chapter
- **Group** — related records within a publication, such as forms within a publication containing non-form-related material as well
- **Field** — region representing a constituent part within the corresponding overall content, such as the date field within a case
- **Highlighter** — a user-created and -named visual enhancement for calling attention to content in a shadow file (see “Highlighting Content in Shadow Files,” on page 96)
- **Note** — a user-created annotation posted to a shadow file (see “Annotating Content in Shadow Files,” on page 92)
Changing Search Range

Note: For information on shadow files, see Chapter 13, "Customizing Publication Content," beginning on page 91, and, specifically, "Creating and Opening Shadow Files," on page 91.

Note that some of these elements — including pop-ups, highlighters, and notes — are not searched when executing a typical query using either the Advanced Query window or a query template. Thus, only by changing search breadth in this manner can you search these elements.

**IMPORTANT!** While it is possible to apply this type of search to all open publications, note that structural elements may vary from publication to publication; thus, in order to ensure the effectiveness of such a search, you may first want to verify that all open publications have the designated element and, if applicable, sub-element.

**Note:** You can change search breadth in this manner using either the Advanced Query window or a query template as the search mechanism. Note, however, that query templates by design focus on certain structural elements, allowing you to perform a scope search without having to know the underlying search syntax.

To search a structural element within one or all open publications

1. Open the publication(s) in which you want to search the structural element. (For instructions on opening a publication, see “Opening a Publication,” on page 8.)

   **Note:** If you are planning to search highlighters or notes, be sure to open the shadow file(s) corresponding to the publication(s). See Chapter 13, “Customizing Publication Content,” for further information on shadow files.

   **Tip:** If you are planning to search only one publication, note that you can further refine search range by selecting to search the structural element in only certain divisions of that publication. To do so, you must first select the desired division(s) as outlined in steps 2 and 3 under “To search selected portions of the active publication,” beginning on page 49. Then complete the remaining steps of this procedure.
2. Open the Advanced Query window or the desired query template, as applicable:
   • **To open the Advanced Query window**, press the F2 key or press \texttt{ALT} + \texttt{S} to open the Search menu then choose \textit{Advanced Query}.
   \textbf{OR}
   • **To open a query template**, press \texttt{ALT} + \texttt{S} to open the Search menu then choose the corresponding name from the bottom of the menu.

3. In the query input field, type an open square bracket.
   The Word Wheel list changes to display a list of the structural elements in the active publication.

   \begin{quote}
   \textbf{Tip:} If you are using the Advanced Query window and plan to search all open publications, you may want to verify that the chosen element (and, if applicable, sub-element) is present in all those publications before proceeding. To do so, activate another publication by pressing \texttt{CTRL} + \texttt{TAB}, then repeat step 3, above, to display the list of structural elements in that publication. Repeat this process for all open publications.
   \end{quote}

4. In the Word Wheel, put the focus on the desired structural element then press \texttt{CTRL} + \texttt{ENTER}.
   The chosen element name is inserted following the open bracket in the query input field.

   \begin{quote}
   \textbf{Note:} Certain elements — including level, field, highlighter, and group — have sub-elements from which you must choose in order to completely define the scope of your search. In such a case, once you choose the element, the Word Wheel will again change to display a list of corresponding sub-elements. Simply put the focus on the desired sub-element then press Ctrl + Enter to insert it following the element name in the Query For field.
   \end{quote}

5. Following the element or sub-element name in the query input field, type a close bracket.

6. Following the close bracket in the query input field, type your query.
The Word Wheel scrolls to highlight the word most closely matching your input.

**Note:** For additional information, see Chapter 6, “Formulating a Query,” and “Building a Query from Words in the Active Infobase,” on page 44.

7 Apply your search by activating the **OK** button.

**Tip:** If you are using the Advanced Query window and are running a search of all open publications, instead activate the **Apply to All** button.

The given search mechanism closes, and the search results are displayed in the Contents, Document, and Hit List panes. (For further information, see “Viewing Search Results,” beginning on page 65.)

**Note:** If you have enabled the *Headings with Hits* option, the table of contents is updated to list only those searched levels containing records with hits. (See “Viewing Search Results Using the Table of Contents,” on page 67, for more information.)

### Searching All Open Publications

In addition to narrowing a search, the *LexisNexis CD* application also offers you the option of broadening a search to a full-content search of all open publications.

**Note:** To change search breadth in this manner, you must use the Advanced Query window as your search mechanism.

- To search the full content of all open publications
  1. Open the desired publications (see “Opening a Publication,” on page 8).
  2. Open the Advanced Query window in one of the following ways:
     - Press the F2 key.
     * **OR**

*LexisNexis CD User’s Guide*
Changing Search Range

- Press ALT + S to open the Search menu then choose Advanced Query.

3 In the Query For field, type your query.

4 Apply your search by activating the Apply to All button.

The Advanced Query window closes, and the search results are displayed in the Contents, Document, and Hit List panes. (For further information, see “Viewing Search Results,” beginning on page 65.)

Searching All Publications in a Given Directory

In addition to narrowing a search to only certain publication divisions or structural elements, the LexisNexis CD application also offers you the option of broadening a search to the full-content of all publications in a given directory on your computer, regardless of whether the publications are open at the time.

- To search all publications in a given directory
  1 Open the Find Infobases dialog box in one of the following manners:
    - Press CTRL + F.
    OR

Note: See Chapter 6, “Formulating a Query,” and “Building a Query from Words in the Active Infobase,” on page 44, for additional information.

Note: If you have enabled the Headings with Hits option, the table of contents is updated to list only those searched levels containing records with hits. (See “Viewing Search Results Using the Table of Contents,” on page 67, for more information.)
Changing Search Range

- Press ALT + F to open the File menu then choose Find Infobases.

2 In the Query field, type your query.

**Note:** See Chapter 6, “Formulating a Query,” for additional information.

3 Indicate the target directory in one of the following ways:

- In the Look in field, type the full path of the directory.

**OR**

- Activate the Browse button then navigate to the directory.

**Tip:** If the target directory has subfolders containing publications that you want to include in your search, be sure to also put the focus on the Include Subfolders option then press the SPACEBAR.

4 Activate the Find Now button.

Your search is run and the results listed in the area at the bottom of the Find Infobases dialog box.

**Tip:** To go to the first hit in a publication, put the focus on the publication title in the results list then press ENTER. To run another search of all publications in a given directory, activate the New Search button and repeat steps 2 through 4.
Chapter 8  Extending Search Functionality

The LexisNexis® CD application provides a number of features allowing you to extend search functionality. Specifically, you can do the following:

- Clear a search
- View search history and/or rerun a previous search
- Edit a search
- Search updated case content on the lexis.com® service

Clearing a Search

When you are done reviewing the results of a search, you may want to run a new search or clear hit highlighting from relevant publication content to ease reading. The LexisNexis CD application allows you to quickly and easily clear a search.

- To clear a search
  
  Press ALT + S to open the Search menu then choose Clear Query.

  Search results are cleared from the Hit List pane and hit highlighting is cleared from publication content in the Document pane.

Viewing Search History and Rerunning a Previous Search

In certain situations, you may want to review searches run since opening a publication and/or re-run a previous search. For example, you may have cleared a search in order to research a different topic, only to realize that you neglected to note an item of significance related to the previous search. Using the Show History feature, you can quickly and easily view all searches run since the given publication was opened and re-run any such search, regardless of the search mechanism used to perform the search.
To view search history

After running one or more searches, press ALT + S to open the Search menu then choose Show History.

The Show History dialog box opens, displaying a list of searches run (as well as links completed) since you opened the given publication.

*Tip*: Searches are listed in reverse chronological order, i.e., the most recently performed search is listed first. Also reflected in the list are instances of cleared queries, indicated by the word Query without subsequent text.

To re-run a previous search

1. After running one or more searches, press ALT + S to open the Search menu then choose Show History.

   The Show History dialog box opens, displaying a list of searches run (as well as links completed) since you opened the given publication.

   *Tip*: Searches are listed in reverse chronological order, i.e., the most recently performed search is listed first. Also reflected in the list are instances of cleared queries, indicated by the word Query without subsequent text.

2. Re-run the desired search by putting the focus on the corresponding search listing, then pressing ENTER or activating the Go To button.

   The Show History dialog box closes, and the results of the re-run search are displayed in the Contents, Document, and Hit List panes. (For further information, see “Viewing Search Results,” beginning on page 65.)

   *Note*: If you have enabled the Headings with Hits option, the table of contents is updated to list only those searched levels containing records with hits. (See “Viewing Search Results Using the Table of Contents,” on page 67, for more information.)
Editing a Search

After running a search, you may want to hone the corresponding query to eliminate unwanted hits.

- If using the Advanced Query window, you can access and edit any search run since the given publication was opened.
- If using either the Query dialog box or a query template, you can access and edit only the most recent search performed since the given publication was opened.

**IMPORTANT!** When you access a previously run search, note that only the query itself is recalled. Thus, if you narrowed the original search to only certain divisions of the active publication (by selecting those divisions in the table of contents) and want to do the same with the edited search, you must reselect the desired divisions before editing the corresponding query.

- **To edit any previous search run during the current session using the Advanced Query window**

  1. After running one or more searches using the Advanced Query window, open the window in one of the following manners:
     - Press the F2 key.
     - OR
• Press ALT + S to open the Search menu then choose Advanced Query.

2 Press the TAB key until the focus is on the Prev button, then press the SPACEBAR or ENTER key.
The most recently run query is displayed in the Query For field.

3 Locate the desired query, as applicable:
• If the most recently run query is the desired query, proceed to step 4.

   OR

• If the most recently run query is not the desired query, activate the Prev button (as described in step 2, preceding) until the desired query is displayed.

4 Edit the query as desired.

5 Activate the OK button.
The Advanced Query window closes, and the results of your edited search are displayed in the Contents, Document, and Hit List panes. (For further information, see “Viewing Search Results,” beginning on page 65.)

Note: For additional information, see “Formulating a Query,” on page 37, and “Building a Query from Words in the Active Information,” on page 44. Note that you can also frame a query so that only certain structural elements within the publication will be searched. See “Searching a Structural Element (Scope) in One or All Open Publications,” on page 51, for further details.

Note: If you have enabled the Headings with Hits option, the table of contents is updated to list only those searched levels containing records with hits. (See “Viewing Search Results Using the Table of Contents,” on page 67, for more information.)

To edit the most recent search run using the Query dialog box or a query template

1 After running a search using the Query dialog box or a query template, open the applicable search mechanism as follows:
To open the Query dialog box, either press the F3 key or press ALT + S to open the Search menu then choose Query.

OR

To open a query template, press ALT + S to open the Search menu then choose the corresponding name from the bottom of the menu.

The search mechanism opens, displaying the previous query in the applicable field(s).

**Tip:** If the previous query is not displayed, press ALT + T to open the Tools menu then choose Options. In the Options dialog box, activate the Query tab then put the focus on the Previous query in query dialog option and press the SPACEBAR until a checkmark appears in the box. Finally, activate the OK button to close the Options dialog box.

2 Edit the query as desired.

**Note:** For additional information, see “Formulating a Query,” on page 37. If you are working in a query template, note that you can edit your query so that it uses words from the active infobase and/or will be applied to only certain structural elements within the publication. See “Building a Query from Words in the Active Infobase,” on page 44, and “Searching a Structural Element (Scope) in One or All Open Publications,” on page 51, for further details.

3 Activate the OK button.

The given search mechanism closes, and the results of your edited search are displayed in the Contents, Document, and Hit List panes. (For further information, see “Viewing Search Results,” beginning on page 65.)

**Note:** If you have enabled the Headings with Hits option, the table of contents is updated to list only those searched levels containing records with hits. (See “Viewing Search Results Using the Table of Contents,” on page 67, for more information.)
Searching Updated Case Content on the *lexis.com* Service

After you run a search of a case collection, the *LexisNexis CD* application allows you to re-run the same search on the *lexis.com* online research service. In this way, you can search any cases that may have been added to the collection since the most recent CD release.

The *LexisNexis CD* application simplifies this process by linking directly to the *lexis.com* service and automatically translating the search into the syntax required to re-run the search on that service.

To search updated case content on the *lexis.com*® service

1. After running a search of a case collection using the *LexisNexis CD* application, press **SHIFT + C** or press **ALT + L** to open the *LexisNexis* menu then choose **Case Update**.

One of the following happens:

- If you have not previously set the *lexis.com* service to remember your sign-on information, your browser opens to the *lexis.com* Sign On page. Proceed to step 2.

  OR

- If you have previously set the *lexis.com* service to remember your sign-on information, your browser opens to the Enter Search Terms page on the *lexis.com* service. Proceed to step 4.

2. In the *lexis.com* Sign On dialog, type your *LexisNexis ID* and your *Password* in the corresponding fields.

   **Note:** If you want to use a secure connection or want the system to remember your sign-on information in the future, put the focus on the corresponding option(s) and press the **SPACEBAR**. Note that if you elect to have the system remember your sign-on information, the Sign On page will not be displayed the next time you use the Case Update feature.

3. Activate the **Sign On** button.

   The *lexis.com* service opens to the Enter Search Terms page, where your translated query is displayed.

4. On the Enter Search Terms page, activate the **Search** button.
Your search results are displayed in the browser window.

After viewing the search results, sign off and close the browser window for the lexis.com service.

The LexisNexis CD main window is again revealed.
Chapter 9  Viewing Search Results

Viewing search results in the LexisNexis® CD application requires an understanding of the following:

- Post-search changes to the main window
- Means of viewing search results
- Limiting publication content displayed after a search

This chapter outlines each of these topics and, where applicable, provides instructions for performing the given task.

Understanding Post-Search Changes to the Main Window

When you first run a search after opening the LexisNexis CD application, the main window reflects the changes outlined following:

- The focus in the Document pane moves to the beginning of the first record containing a hit, or query match. Within the publication content, each hit is highlighted.
- The Hit List pane displays a list of records containing hits.

**Note:** When you run a search using the Query dialog box, the program returns as search results only up to 50 records containing hits. Furthermore, those records are ranked according to relevancy. Thus, entries in the hit list may not reflect the order of their occurrence in publication content. For further details, see “Search Results Compilation in Natural Language Searching,” on page 47

Understanding Means of Viewing Search Results

Depending on your reasons for running a search, you may want to view the results of that search at varying degrees of detail. For instance, if you were trying to find a specific document that you would recognize upon seeing its title, you may want to view at a glance those records returned as search results. If, on the other hand, you were performing initial research on a topic with which you are not all that familiar, you
may want to focus on each hit within the document. The LexisNexis CD application is designed to afford you such flexibility in viewing search results.

Viewing Search Results at a Glance

The LexisNexis CD application offers two vehicles for viewing search results at a glance:
- The hit list
- The table of contents

Viewing Search Results Using the Hit List

When you complete a search, the Hit List pane by default displays a list of records containing hits in the order in which the records appear in publication content.

When you run a search using the Query dialog box, the program returns as search results only up to 50 records containing hits. Furthermore, those records are ranked according to relevancy. Thus, entries in the hit list may not reflect the order of their occurrence in publication content. For further details, see “Search Results Compilation in Natural Language Searching,” on page 47.

Each record entry in the hit list reflects complete source information for that record. Record entries are set flush left in the Hit List pane. Each record entry in the hit list serves as a direct jump link to the beginning of that record in publication content.

Tip: To move among records containing hits or among hits within records, you may also use the aids for navigating search results in publication content. (See “Viewing Search Results in Detail,” on page 68.)
To view results within the hit list
Press the **UP ARROW**, **DOWN ARROW**, **LEFT ARROW**, and **RIGHT ARROW** keys to adjust your view as needed to view results.

To display record content from the hit list
1. In the hit list, press the **UP ARROW** or **DOWN ARROW** keys to adjust your view until you find a record that you want to display.
2. Display the record by pressing **ENTER**.
The view in the Document pane scrolls to the beginning of the record in publication content.

**Viewing Search Results Using the Table of Contents**
Like the hit list, the table of contents can be used as a vehicle for viewing search results at a glance. Specifically, the **Headings with Hits** option causes the table of contents to list only those searched levels containing records with hits.

**Note:** This option takes precedence over automatic synchronization of the table of contents. Thus, if after running a search, you navigate to a record having no hits, the table of contents will not synchronize to your current location. To re-enable automatic synchronization in such an instance, either disable the **Headings with Hits** option (see “To enable or disable display of only headings with hits in the table of contents,” on page 67) or clear the search (see “Clearing a Search,” on page 57).

To enable or disable display of only headings with hits in the table of contents
1. Press **ALT + T** to open the **Tools** menu then choose **Options**.
The Options dialog box opens.
2. Activate the **Contents** tab.

**Tip:** To move from tab to tab within the same row of tabs in the Options dialog box, press the **RIGHT ARROW** or **LEFT ARROW** key; to move between tab rows, press the **UP ARROW** or **DOWN ARROW** key.
3 Indicate your preference for having the table of contents display only headings with hits after a search:
   • To enable this option (i.e., have the table of contents list only headings with hits after a search), place the focus on the Headings with hits option then press the SPACEBAR until a checkmark appears in the check box.
     OR
   • To disable this option, place the focus on the Headings with hits option then press the SPACEBAR until the checkmark is cleared from the check box.

4 Activate the OK button.
Your preference for having the table of contents list only headings with hits after a search is set, and the Options dialog box closes.

**Note:** If you previously ran a search and your view is set to display the table of contents, only those headings containing records with hits will be displayed in the table of contents as soon as you close the Options dialog box.

### Viewing Search Results in Detail

The *LexisNexis CD* application provides a number of navigation aids to assist you in viewing search results at the level of hits (query matches) within publication content. Specifically, the following navigational commands are offered:

- The **Next Hit** command moves the focus in the Document pane to the hit immediately following the currently highlighted hit in the currently displayed record.

  **Tip:** If there is no “next hit” within the currently displayed record, executing this command will move the focus to the first hit in the next record containing hits. If you navigate to the last hit in publication content, the Next Hit option becomes unavailable.

- The **Previous Hit** command moves the focus in the Document pane to the hit immediately preceding the currently highlighted hit in the currently displayed record.
The Next Record Hit command moves the focus in the Document pane to the beginning of the first record that follows the currently displayed record and contains hits.

**Tip:** If you navigate to the last record containing a hit, this command becomes unavailable.

The Previous Record Hit command moves the focus in the Document pane to the beginning of the first record that precedes the currently displayed record and contains hits.

**Tip:** If the focus is currently on the first hit in publication content and you execute this command, the focus will move to the beginning of the record containing the first hit.

To highlight and move the focus to the next hit within a record
Press the F4 key.

**OR**
Press ALT + N to open the Navigate menu then choose Next Hit.

**Tip:** If there is no next hit within the currently displayed record, executing the command will move the focus to the first hit in the next record containing hits.

To highlight and move the focus to the previous hit within a record
Press SHIFT + F4.

**OR**
Press ALT + N to open the Navigate menu then choose Previous Hit.
To highlight and move the focus to the next record containing hits

Press the F5 key.

OR

Press ALT + N to open the Navigate menu then choose Next Record Hit.

Tip: If you navigate to the last record containing a hit, this command becomes unavailable.

To highlight and move the focus to the previous record containing hits

Press SHIFT + F5.

OR

Press ALT + N to open the Navigate menu then choose Previous Record Hit.

Tip: If the focus is currently on the first hit in publication content and you execute this command, the focus will move to the beginning of the record containing the first hit.

Limiting Content Displayed After a Search

After you run a search, the LexisNexis CD application defaults to display complete publication content in the Document pane, highlighting hits within the content to help you find relevant information. You can, however, further hone in on search results by instructing the program to always limit the content displayed in the Document pane after a search to only those records containing hits.

Note: When setting your program preferences to limit the content displayed after a search, your preference is reflected the next time you run a search.
To limit the content displayed after a search

1. Press \texttt{ALT + T} to open the \textit{Tools} menu then choose \textbf{Options}. The Options dialog box opens.

2. Activate the \textbf{Query} tab.

\begin{quote}
\textit{Tip:} To move from tab to tab within the same row of tabs in the Options dialog box, press the \texttt{RIGHT ARROW} or \texttt{LEFT ARROW} key; to move between tab rows, press the \texttt{UP ARROW} or \texttt{DOWN ARROW} key.
\end{quote}

3. Place the focus on the \textbf{Narrowed view after each query} option then press the \texttt{SPACEBAR} until a checkmark appears in the check box.

4. Press the \texttt{DOWN ARROW} to place the focus on and activate the \textbf{Records with hits} sub-option.

\begin{quote}
\textit{Tip:} Alternatively, you can activate the \textbf{Partitions with hits} sub-option.
\end{quote}

5. Activate the \textbf{OK} button. The Options dialog box closes, again revealing the main window.

\begin{quote}
\textit{Note:} Your chosen preference will be reflected the next time you run a search.
\end{quote}
Chapter 10 Printing and Reusing Content

The LexisNexis® CD application offers flexibility in printing information, allowing you to print any of the following for the active publication:

- Partial content
- Selected table of contents entries
- Specified hit list entries

The LexisNexis CD application also provides options for transferring content to other applications, thereby allowing you to reuse* that content in your own documents. You can do either of the following:

- Copy and paste selected content from the LexisNexis CD application
- Export portions of the active publication in a format compatible with an outside application

Printing Content

The LexisNexis CD application provides multiple options for printing content. You can print any of the following for the active publication:

- Content as selected in the Document pane
- Content of selected divisions or specified records in the active publication
- Table of contents entries for specified records
- Specified hit list entries for the most recently performed search of the active publication

Regardless of the content that you elect to print, you can further hone the results by setting printing preferences.

Instructions for performing each of these tasks follow.

* Subject to Terms and Conditions
To print content selected in the active publication

1. Open the publication from which you want to print (see “Opening a Publication,” on page 8).
2. In the Document pane, position your cursor at the beginning of the desired content.
3. Select the desired content by pressing and holding the **SHIFT** key, pressing and holding the **RIGHT ARROW** key until the desired content is selected, then releasing the **SHIFT** and **RIGHT ARROW** keys.
   The desired content is highlighted.
4. Open the Print dialog box in one of the following manners:
   - Press **CTRL + P**.
   - **OR**
   - Press **ALT + F** to open the **File** menu then choose **Print**.
5. Activate the **OK** button.
   The Print dialog box closes and the selected content prints to the designated printer.

To print the content of selected divisions in the active publication

1. Open the publication from which you want to print (see “Opening a Publication,” on page 8).
2. Press **ALT + T** to open the **Tools** menu then choose **Options**.
   The Options dialog box opens.
3. Activate the **Print** tab.

**Tip:** To move from tab to tab within the same row of tabs in the Options dialog box, press the **RIGHT ARROW** or **LEFT ARROW** key; to move between tab rows, press the **UP ARROW** or **DOWN ARROW** key.
4 Place the focus on the **Allow interaction between print dialog and TOC** option then press the **SPACEBAR** until a checkmark appears in the check box.

5 Activate the **OK** button to close Options dialog box.

6 Expand or collapse the table of contents hierarchy to display the heading(s) for the desired content.

7 Select the desired divisions by placing the focus on the corresponding entry then pressing the **SPACEBAR**.

<table>
<thead>
<tr>
<th><strong>Tip:</strong> If check boxes are not currently displayed in the table of contents, do one of the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• To display check boxes only for the current publication and session, press <strong>ALT + V</strong> to open the <strong>View</strong> menu then choose <strong>Show Check Boxes</strong>.</td>
</tr>
<tr>
<td>• To display check boxes for all publications and sessions, press <strong>ALT + T</strong> to open the <strong>Tools</strong> menu then choose <strong>Options</strong>. In the Options dialog box, activate the <strong>Contents</strong> tab then put the focus on the <strong>Checked Branches</strong> option and press the <strong>SPACEBAR</strong> until a checkmark appears. Finally, activate the <strong>OK</strong> button to close the Options dialog box.</td>
</tr>
</tbody>
</table>

8 Open the Print dialog box in one of the following manners:

• Press **CTRL + P**.

**OR**

• Press **ALT + F** to open the **File** menu then choose **Print**.

9 Press the **TAB** key until the **Section** option is enabled.

| **Note:** If you neglected to select the desired divisions before opening the Print dialog box, you can indicate your selections here. To do so, expand the hierarchy by pressing the **+** key at the desired level and until the desired divisions are displayed, use the **ARROW** keys to place the focus on the desired division, then press the **SPACEBAR** to select the division, repeating until all desired divisions are selected. |

10 Press the **TAB** key to navigate to the additional print options (e.g., printer, number of columns), setting as desired, then activate the **OK** button.
The Print dialog box closes and the content of the chosen divisions prints to the designated printer.

**IMPORTANT!** After printing the desired content, be sure either deselect the entries in the table of contents or disable the Allow interaction between print dialog and TOC option via your Print preferences (see “Setting Printing Preferences,” on page 79). Failure to do so may cause undesired results when subsequently running a search or printing.

To print content of specified records in the active publication

**Note:** In order to print the content of specified records, you must know the corresponding record numbers. If you do not have this information, you may instead want to print the content of selected publication divisions (see “To print the content of selected divisions in the active publication,” on page 74).

**Tip:** See “Setting Printing Preferences,” on page 79, for information on further honing your printing results.

1. Open the publication from which you want to print (see “Opening a Publication,” on page 8).
2. Open the Print dialog box in one of the following manners:
   - Press CTRL + P.
   - OR
   - Press ALT + F to open the File menu then choose Print.
3. Press the TAB key until the Records option is enabled.
4. In the From field, type the number of the first record whose content you want to print, and in the To field, type the number of the last record whose content you want to print.
5. Press the TAB key to navigate to the additional print options (e.g., printer, number of columns), setting as desired, then activate the OK button.

The Print dialog box closes and the content of the specified records prints to the designated printer.
To print table of content entries for specified records in the active publication

**Note:** In order to print the table of contents entries for specified records, you must know the corresponding record numbers.

**Tip:** See “Setting Printing Preferences,” on page 79, for information on further honing your printing results.

1. Open the publication from which you want to print (see “Opening a Publication,” on page 8).
2. Open the Print dialog box in one of the following manners:
   - Press CTRL + P.
   - Press ALT + F to open the File menu then choose Print.
3. Press the TAB key until the focus is on the row of tabs, then activate the Print Contents tab.
4. Press the TAB key until the Records option is enabled.
5. In the From field, type the number of the first record whose table of contents entry you want to print, and in the To field, type the number of the last record whose table of contents entry you want to print.
6. Press the TAB key to navigate to the additional print options (e.g., printer, number of columns), setting as desired, then activate the OK button.

The Print dialog box closes and the table of contents entries for the specified records print to the designated printer.

**Tip:** To move from tab to tab in the Print dialog box, press the RIGHT ARROW or LEFT ARROW key.

To print specified hit list entries for the most recently performed search of the active publication

**Tip:** See “Setting Printing Preferences,” on page 79, for information on further honing your printing results.
1. Open the publication from which you want to print (see “Opening a Publication,” on page 8).
2. Run a search of the publication.
3. Open the Print dialog box in one of the following manners:
   - Press CTRL + P.
   - OR
   - Press ALT + F to open the File menu then choose Print.
4. Press the TAB key until the focus is on the row of tabs, then activate the Print Hitlist tab.
5. Press the TAB key until the Records option is enabled.
6. In the From field, type the number of the first hit list entry that you want to print, and in the To field, type the number of the last hit list entry that you want to print.
7. Press the TAB key to navigate to the additional print options (e.g., printer, number of columns), setting as desired, then activate the OK button.

   The Print dialog box closes and the specified hit list entries for the most recently performed search of the active publication print to the designated printer.

*Note:* When you print hit list entries, only the entries as they appear in the hit list are printed; the corresponding content is not printed.

*Tip:* To move from tab to tab in the Print dialog box, press the RIGHT ARROW or LEFT ARROW key.

*Note:* Each of these values refers to the entry’s number in the hit list as opposed to the corresponding record’s number in the overall publication. Thus, for example, the third record in the hit list may be record 342 in the overall publication. To instruct the program to start the print output with the hit list entry for this record, then, you would enter 3 in the From field.
Setting Printing Preferences

Regardless of the content that you elect to print, you can further hone the results by setting printing preferences.

To set printing preferences

1. Press ALT + T to open the Tools menu then choose Options. The Options dialog box opens.
2. Activate the Print tab.

Tip: To move from tab to tab within the same row of tabs in the Options dialog box, press the RIGHT ARROW or LEFT ARROW key; to move between tab rows, press the UP ARROW or DOWN ARROW key.

3. In the Show area, indicate whether you want to hide or show the following in printed material, placing the focus on the corresponding option then pressing the SPACEBAR to either insert a checkmark in the check box to show the item or clear a checkmark to hide the item:
   - **Query results** (hit highlighting when printing either publication content or the hit list)
   - **Inline headings** (full source information for content)
   - **Highlighter attributes** (visual enhancement applied by the user to content in a shadow file)
   - **Link attributes** (visual enhancement, typically understroking, used to indicate a link in publication content)
   - **Field attributes** (visual enhancement used to indicate a given field in publication content)
   - **Hidden text** (material specific to the production of the active publication)
   - **Notes** (annotations posted by the user to content in a shadow file)

Note: If you elect to show inline headings, note that full source information (e.g., volume, chapter, and section) will print preceding each record printed.
4 Indicate whether you want printed material to reflect page breaks coded into publication content, inserting a checkmark in the Page breaks active check box to include page breaks or clearing a checkmark to exclude page breaks.

5 In the corresponding field, indicate the desired number of Columns for the print output.

6 In the Inline heading font area, select the Name and Size of the font that you want to use for printing inline headings (i.e., full source information).

7 Activate the OK button.
   The Options dialog box closes, and your printing preferences are set.

### Transferring Content to Other Applications

The LexisNexis CD application provides options for transferring content to other applications, thereby allowing you to reuse that content in your own documents (subject to Terms and Conditions).

The options for transferring content are as follows:
- Copying content from the active publication in the LexisNexis CD application and pasting it into another application.
- Exporting portions of the active publication from the LexisNexis CD application in a format compatible with another application.

### Copying and Pasting Content

One method of transferring content from the LexisNexis CD application to an outside program is copying and pasting, much as you do between other applications.
To copy and paste content from the active publication

1. Open the applicable publication (see “Opening a Publication,” on page 8).
2. In the Document pane, position your cursor at the beginning of the desired content.
3. Select the desired content by pressing and holding the Shift key, pressing and holding the Right Arrow key until the desired content is selected, then releasing the Shift and Right Arrow keys.
   The desired content is highlighted.
4. Execute the copy command in one of the following ways:
   - Press Ctrl + C.
   - Press Alt + E to open the Edit menu then choose Copy.
5. Open the destination program (i.e., the application into which you want to paste the copied content).
6. In the destination program, execute the paste command in one of the following ways:
   - Press Ctrl + V.
   - Press Alt + E to open the Edit menu then choose Paste.
   The content is pasted in the destination program.

Exporting Content

A second method of transferring content from the LexisNexis CD application to an outside program is exporting the content in a format compatible with that outside program. The LexisNexis CD application allows you to export any of the following for the active publication:

- Content as selected in the Document pane
- Content of selected divisions
- Only that content containing hits resulting from the most recently performed search

Procedures for exporting each of the preceding elements follow.
To export publication content as selected in the Document pane

**Note:** When you select text in the Document pane for purposes of exporting, note that the entire record is considered selected; thus, if you want to export a given paragraph that is part of a record containing multiple paragraphs, all paragraphs will be exported together as a single unit.

**Tip:** Using this method, you can export only contiguous content segments. If you would like to export noncontiguous content segments, consider exporting content of selected divisions (see "To export content of selected divisions in the active publication," on page 83).

1. Open the applicable publication (see “Opening a Publication,” on page 8).
2. In the Document pane, position your cursor at the beginning of the desired content.
3. Select the desired content by pressing and holding the **SHIFT** key, pressing and holding the **RIGHT ARROW** key until the desired content is selected, then releasing the **SHIFT** and **RIGHT ARROW** keys.
   The desired content is highlighted.

   **Tip:** If the content that you want to export is contained in a single paragraph, you need only position your cursor anywhere within that paragraph. Note, however, that if the paragraph is part of a record containing paragraphs in addition to the selected paragraph, all paragraphs in the record will be exported.

4. Press **ALT + F** to open the **File** menu then choose **Export**.
   The Export dialog box opens.
5. In the corresponding areas of the dialog box, navigate to the drive and directory in which you want to store the export file, as applicable.
6. In the **File Name** field, type the desired name for the export file.
7. In the **Save as Type** field, choose the desired format for the export file.
8. In the **Export Range** field choose **Selected Records**.
9 Activate the **Export** button.
   The selected publication content is exported in the designated format.

- **To export content of selected divisions in the active publication**
  1 Open the desired publication (see “Opening a Publication,” on page 8).
  2 In the table of contents, expand the hierarchy until the desired divisions are displayed, then select the desired division(s) by placing the focus on the corresponding entry then pressing the **SPACEBAR**.
  3 Press **ALT + F** to open the **File** menu then choose **Export**.
     The Export dialog box opens.
  4 In the corresponding areas of the dialog box, navigate to the drive and directory in which you want to store the exported file, as applicable.
  5 In the **File Name** field type the desired name for the export file.
  6 In the **Save as Type** field, choose the desired format for the export file.
  7 In the **Export Range** field choose **Checked Branches**.
  8 Activate the **Export** button.
     The content of the selected divisions is exported in the designated format.

**Tip:** You can also export content of selected divisions by modifying the above procedure in the following manner:

1. Following step 2, position your cursor anywhere in the Document pane then press **ALT + V** to open the **View** menu and choose **Checked Branches**.
2. At step 7, choose **Current View**.
To export only content containing hits

1. Open the desired publication (see “Opening a Publication,” on page 8).
2. Run a search of the publication.
4. Press ALT + V to open the View menu then choose Records with Hits.
5. Press ALT + F to open the File menu then choose Export.
   The Export dialog box open.
6. In the corresponding areas of the dialog box, navigate to the drive and directory in which you want to store the exported file, as applicable.
7. In the File Name field type the desired name for the export file.
8. In the Save as Type field choose the desired format for the export file.
9. In the Export Range field choose Current View.
10. Activate the Export button.
    The content containing hits is exported in the designated format.
Chapter 11 Checking the Current Status of Information

The LexisNexis® CD application provides easy access to the Shepard’s® Citations Service on the lexis.com® research system, enabling Shepard’s subscribers to supplement their research efforts.

Checking the current status of information requires an understanding of the following:

- The Shepard’s Citations Service
- Means of checking a citation

This chapter outlines each of these topics and, where applicable, provides instructions for performing the given task.

The Shepard’s Citations Service

The Shepard’s Citations Service provides the tools you need to determine the usefulness and validity of legal documents for your research and to find additional supportive documents. This service combines Shepard’s thorough information and analysis with the speed and ease of electronic legal research. With Shepard’s Citations Service, you can simultaneously search the bound case volumes and supplements of Shepard’s citation products for citations reported in Federal, State, and National Reporter System publications.

You can use the Shepard’s Citations Service to find parallel citations, a case’s history, citations to a case, editorial analysis of a case, treatment of a case, and citations from law reviews, bar journals, annotations, and legal treatises.

Checking a Citation

You can check a citation at anytime while using the LexisNexis CD application.

- To check a citation
  1. Open the Check a Citation dialog box in one of the following manners:
• Press SHIFT + K.

OR

• Press ALT + X to open the LexisNexis menu then choose Check a Citation.

2 In the text field, type the citation for a case.

3 Enable the option corresponding to the type of report that you want to receive.

SHEPARD’S® for Validation — To limit your results to subsequent appellate history and those citing references that have editorial analysis or that were added within the most recent two months.

SHEPARD’S® for Research — To perform a more comprehensive legal research. The FULL format provides prior history and subsequent appellate history, as well as all citing references from cases, statutes, law reviews and periodicals, and other secondary sources.

4 Press ENTER or activate the Check button.

One of the following happens:

• If you have not previously set the lexis.com service to remember your sign-on information, your browser opens to the lexis.com Sign On page. Proceed to step 5.

OR

• If you have previously set the lexis.com service to remember your sign-on information, your browser opens to the Shepard’s Citations Service on the lexis.com legal research system, where the results of your citation check are displayed. Proceed to step 7.

5 In the lexis.com Sign On dialog, type your LexisNexis ID and your Password in the corresponding fields.

**Note:** If you want to use a secure connection or want the system to remember your sign-on information in the future, put the focus on the corresponding option(s) and press the SPACEBAR. Note that if you elect to have the system remember your sign-on information, the Sign On page will not be displayed the next time you check a citation.

6 Activate the Sign On button.
The results of your citation check are displayed in the browser window.

7 When you are finished reviewing the results of your citation check, sign off and close the browser window for the Shepard's Citations Service on the lexis.com legal research system.

The LexisNexis CD main window is again revealed.
Chapter 12  Linking to the *lexis.com*®
Service

The *LexisNexis* CD application provides easy access to the *lexis.com* service, a powerful online research system offering subscribers case-finding and analysis tools including the following:

- **LEXIS® Search Advisor** — Designed to help you begin your online research, LEXIS Search Advisor enables you to create effective searches by selecting terms from a hierarchy of law and related legal topics. As soon as a case is added online, LEXIS Search Advisor can retrieve it.

- **Core Terms** — Originally introduced as an analysis tool, Core Terms provide a quick summary of key terms and facts drawn from a case. Unlike conventional headnotes, which focus only on legal issues, Searchable Core Terms enable you to search both points of fact and law.

- **Case Summaries and LexisNexis® Headnotes (Core Concepts)** — To assist you in analyzing critical information, Case Summaries and LexisNexis Headnotes (Core Concepts) contain exclusive editorial summary content. Case Summaries are written by a team of legal editorial experts to give you a quick, concise understanding of the case’s impact and relevance. Case Summaries and LexisNexis Headnotes (Core Concepts) link to relevant sections within a case, to other relevant documents, and to the LEXIS Search Advisor.

You can access the *lexis.com* service directly from the main window of the *LexisNexis CD* application, making it convenient for you to review relevant reference material as part of your work flow.

**Note:** The *lexis.com* research system is a separate service to which you must sign on with the appropriate ID and password as you normally would when accessing that service directly. Note, however, that the *lexis.com* research system does offer you the option of remembering your sign-on information.
To link to the lexis.com service


   One of the following happens:
   - If you have not previously set the lexis.com service to remember your sign-on information, your browser opens to the lexis.com Sign On page. Proceed to step 2.
   - OR
     - If you have previously set the lexis.com service to remember your sign-on information, your browser opens to lexis.com home page. Proceed to step 4.

2. In the lexis.com Sign On dialog, type your LexisNexis or Custom ID and your Password in the corresponding fields.

   Note: If you want to use a secure connection or want the system to remember your sign-on information in the future, put the focus on the corresponding option(s) and press the SPACEBAR. Note that if you elect to have the system remember your sign-on information, the Sign On page will not be displayed the next time you access the lexis.com service.

3. Activate the Sign On button.

4. Navigate the lexis.com service using the procedures that you normally follow.

5. When you are finished, sign off and close the browser window for the lexis.com service.

   The LexisNexis CD main window is again revealed.

Tip: The LexisNexis CD application provides another feature related to the lexis.com service. After you run a search of a case publication, the LexisNexis CD application allows you to rerun the same search on the lexis.com online research service. In this way, you can search any cases that may have been added to the corresponding publication since the most recent CD release. For further details, see “Searching Updated Case Content on the lexis.com Service,” on page 62.)
Chapter 13 Customizing Publication Content

When you subscribe to one or more products on the LexisNexis® CD application, the corresponding content is provided in read-only format, meaning that you can view but cannot modify the content in any way. You can, however, copy publications as shadow files and then customize those files in the following ways:

- Attach notes
- Insert bookmarks
- Highlight content

This chapter outlines each of these topics and, where applicable, provides instructions for performing the given task.

Creating and Opening Shadow Files

A shadow file is a special copy of publication content to which you can post and save notes, bookmarks, and textual enhancement in the form of highlighting. A shadow file is like a transparency placed on top of an original; anything written on the transparency will not alter the original.

**IMPORTANT!** Shadow files are good only for the life of the corresponding publication release; thus, once you receive an updated publication release, you will not be able to use a shadow file created from the previous release.

- To create a shadow file

  ```
  Tip: You can use the same file name as that for the original publication assuming that you use the .SDW file extension.
  ```

1. Open the publication for which you want to create a shadow file (see “Opening a Publication,” on page 8).
2. Press ALT + F to open the File menu then choose New.

The New dialog box appears.
3 In the **File Name** field, type the desired name for the shadow file.

4 Verify that the **File Type** field displays **Folio Shadow File**.

5 In the corresponding areas of the dialog box, navigate to the drive and directory to which you want to save the shadow file, as applicable.

6 Activate the **New** button.
   
The shadow file is created and displayed, as indicated by the word **Shadow** in the title bar of the active window.

**To open an existing shadow file**

1 Initiate the process in one of the following manners:
   - Press **CTRL + O**.
   
   **OR**
   
   - Press **ALT + F** to open the **File** menu then choose **Open**.
   
The Open dialog box appears.

2 In the corresponding areas of the dialog box, navigate to the drive and directory in which the desired shadow file is stored, as applicable.

3 On the list of files select the name of the desired shadow file, then either press **ENTER** or activate the **Open** button:

   **Tip:** Shadow files use the .SDW file extension.

   The shadow file is displayed in the **LexisNexis CD** main window.

**Annotating Content in Shadow Files**

At times, you may want to post commentary to publication content. Using the **LexisNexis CD** Notes feature, not only can you annotate individual paragraphs in shadow files, but you can search the content of those annotations.
Notes are indicated by a note icon in the left margin of shadow file content displayed in the Document pane.

- **To create a note**
  1. Open the applicable shadow file (see “To open an existing shadow file,” on page 92).
  2. In the Document pane, position the cursor anywhere within the paragraph to which you want to attach the note.
  3. Open the Note dialog box in one of the following manners:
     - Press CTRL + N.
     - OR
     - Press ALT + T to open the Tools menu then choose Note.
  4. In the Note dialog box, type the desired text.
  5. When you are done entering the note press the Esc key.
     An alert box opens, prompting you to indicate whether you want to save your input.
  6. Choose Yes.
     The alert box and Note dialog box close, and a note icon appears in the left margin beside the paragraph to which you attached the note.

- **To view note contents**
  Position your cursor anywhere within the paragraph to which the note is attached, then press CTRL + N.
  The Note dialog box opens, displaying the note’s contents.

  **Tip:** To close the note when you are done, press the Esc key.

- **To edit a note**
  1. Open the note (see “To view note contents,” on page 93).
     The Note dialog box opens.
  2. Edit the note as desired.

  **IMPORTANT!** The content of notes can be searched only if you structure your query accordingly. For details, see “Searching a Structural Element (Scope) in One or All Open Publications,” on page 51.
When you are done editing the note press the **ESC** key. An alert box opens, prompting you to indicate whether you want to save your input.

4 Choose **Yes**.
The alert box and Note dialog box close and your edits are saved.

- **To delete a note**
  1 In the Document pane, position your cursor anywhere within the paragraph to which you attached the note.
  2 Delete the note in one of the following ways:
    - Press **CTRL + SHIFT + N**.
    - **OR**
    - Press **ALT + T** to open the **Tools** menu then choose **Remove Note**.

**Bookmarking Content in Shadow Files**

The bookmarking functionality of the *LexisNexis® CD* application provides you with quick and easy access to key information within a publication shadow file. When you later want to access this information, all you need do is choose the corresponding bookmark listing, accessed via the Tools menu. If at some point you find that you no longer need ready access to the information, the *LexisNexis CD* application allows you to easily remove the corresponding bookmark.

**IMPORTANT!** Bookmarks cannot be searched.

- **To bookmark content in a shadow file**
  1 Open the desired shadow file (see “To open an existing shadow file,” on page 92).
  2 In the Document pane, position your cursor at the location that you want to bookmark.
  3 Open the Bookmark dialog box in one of the following ways:
    - Press **CTRL + M**.
    - **OR**
• Press ALT + T to open the Tools menu then choose Bookmark.

4 In the Bookmark dialog, type an identifying Name for the bookmark in the corresponding field.

Note: The more descriptive the bookmark name, the easier it will be to identify the content flagged by the bookmark. Note that bookmark names can be up to 127 characters in length and that you can include up to 1,000 bookmarks per shadow file.

5 Press the TAB key until the focus is on the Set button then press the SPACEBAR or ENTER key.

The Bookmark dialog box closes and the bookmark is set.

To access bookmarked information

1 Open the applicable shadow file (see “To open an existing shadow file,” on page 92).

2 Position your cursor anywhere within the Document pane.

3 Press ALT + T to open the Tools menu then choose Bookmark.

   The Bookmark dialog box opens.

4 In the list of bookmarks position your cursor in the name of the corresponding bookmark, then activate the Go To button.

   The Bookmark dialog box closes and the view in the Document pane scrolls to the location of the bookmark.

To delete a bookmark from shadow-file content

1 Open the applicable shadow file (see “To open an existing shadow file,” on page 92).

2 Position your cursor anywhere within the Document pane.

3 Press ALT + T to open the Tools menu then choose Bookmark.

   The Bookmark dialog box opens.

4 Place the focus on the listing for the bookmark you want to delete.

5 Press the TAB key until the focus is on the Delete button then press the SPACEBAR or ENTER key.

   An alert box opens, prompting you to confirm your desire to delete the bookmark.
6 Choose Yes.
The alert box closes and the bookmark is deleted.

7 Close the Bookmark dialog box by activating the Close button.

Highlighting Content in Shadow Files

Just as you can highlight text in a printed book, the LexisNexis® CD application allows you to visually enhance text in a shadow file for purposes of calling attention to that text. Further, by requiring you to name the different highlighting schemes that you create, the program provides for searching of highlighted content based on the corresponding highlighter name.

To create a highlighter for a shadow file

1 Open the desired shadow file (see “To open an existing shadow file,” on page 92).

2 Position your cursor anywhere within the Document pane.

3 Open the Highlighter dialog box in one of the following manners:
   - Press CTRL + H.
   - OR
   - Press ALT + T to open the Tools menu then choose Highlighter.

4 In the Highlighter dialog box activate the New button.
The New Highlighter dialog box opens.

5 In the Name field, type the desired name for the highlighter.

6 From the Background Color list, choose the desired color option.
7 Activate the OK button.
The New Highlighter dialog box closes, again revealing the Highlighter dialog box.

8 Set desired text formatting for the highlighter or exit the Highlighter dialog box, as desired:
   • To set desired text formatting for the highlighter, activate the Format button. The Highlighter Format dialog box opens.
     Proceed to step 9.
   OR
   • To exit the Highlighter dialog box, proceed to step 10.

9 In the Highlighter Format dialog box, indicate desired text formatting options, then activate the OK button.
The Highlighter Format dialog box closes, again revealing the Highlighter dialog box.

10 Exit the Highlighter dialog box by activating the Close button.

To apply a highlighter to shadow-file content

1 Open the applicable shadow file (see “To open an existing shadow file,” on page 92).

2 In the Document pane, position your cursor at the beginning of the content to which you want to apply the highlighter.

3 Select the desired content by pressing and holding the SHIFT key, pressing and holding the RIGHT ARROW key until the desired content is selected, then releasing the SHIFT and RIGHT ARROW keys.
The desired content is selected.

4 Open the Highlighter dialog box in one of the following manners:
   • Press CTRL + H.
   OR
   • Press ALT + T to open the Tools menu then choose Highlighter.

5 On the list of highlighters in the Highlighter dialog box select the name of the desired highlighter, then activate the Apply button.
The Highlighter dialog box closes, and the selected text is enhanced as defined by the chosen highlighter.

- **To remove highlighting from shadow-file content**
  1. Open the applicable shadow file (see “To open an existing shadow file,” on page 92).
  2. In the Document pane, position your cursor at the beginning of the content from which you want to remove the highlighter.
  3. Select the balance of the content from which you want to remove the highlighting by pressing and holding the *SHIFT* key, pressing and holding the *RIGHT ARROW* key until the desired content is selected, then releasing the *SHIFT* and *RIGHT ARROW* keys.
  The desired content is selected.
  4. Press *ALT* + *T* to open the *Tools* menu then choose *Remove Highlighter*.
  The highlighting is removed.

- **To delete a highlighting scheme from a shadow file**
  1. Open the applicable shadow file (see “To open an existing shadow file,” on page 92).
  2. Position your cursor anywhere within the Document pane.
  3. Open the Highlighter dialog box in one of the following manners:
     - Press *CTRL* + *H*.
     - OR
     - Press *ALT* + *T* to open the *Tools* menu then choose *Highlighter*.
  4. On the list of highlighters in the Highlighter dialog box select the name of the highlighter that you want to delete.
  5. Activate the *Delete* button.
  An alert box opens, prompting you to confirm your desire to delete the highlighter.
  6. Choose *Yes*.
  The alert box closes and the highlighter is deleted from the shadow file.
7 Exit the Highlighter dialog box by activating the Close button.

Note: If the deleted highlighter had previously been applied to any text in the shadow file, that text will no longer be highlighted.
Chapter 14 Managing Data, Rights, and Peripheral-Software Integration

The LexisNexis® CD application provides for significant flexibility in administering the program to best suit the circumstances of your work environment over time. Specifically, the application comes equipped with support utilities allowing you to manage data, access rights, and peripheral-software integration.

This chapter provides instructions for performing each of these administrative tasks.

Managing Library Data

Because your electronic data storage and retrieval needs may change over time, the LexisNexis CD application comes equipped with a tool allowing you to administer library data. Specifically, the Data Manager utility lets you copy installed libraries from CD to a local or network drive, move copied libraries from one location on a local or network drive to another, and delete copied libraries when you no longer need those copies. Once you have moved or copied a library, you can also set the LexisNexis CD application to look for the library in the new location.

Note: Data Manager is available only to standalone users and those network users set up as Administrator. Client users do not have access to Data Manager.

To access Data Manager

1. Open the Start menu in one of the following manners:
   • Press the WINDOWS LOGO key.
   OR
   • Press CTRL + ESC.
   OR
102 Managing Data, Rights, and Peripheral-Software Integration

- Activate the Start button, located on the taskbar in the lower-left corner of your Windows desktop.

2. On the Start menu choose Programs.
4. On the LexisNexis CD on Folio 4 menu choose Data Manager.

Data Manager opens.

Copying a Library from CD

Data Manager allows you to copy installed libraries from CD to a local hard drive or a network location. Copying a library from CD to a local hard drive helps maximize program performance. In a network environment, copying a library to a file server affords multiple users shared access to library data.

- To copy a single-disc library
  1. Insert the library CD into your computer’s CD-ROM drive.
  2. Open Data Manager as outlined under “To access Data Manager,” on page 101.
  3. Choose the desired library from the Please Select a Library drop-down field.
     The pane below the drop-down field lists the disc comprising the selected library.

     **Note:** The disc Path and Drive Info (i.e., path contents) are detailed under each main disc listing. If these specifics are not displayed, put the focus on the main disc listing then press the Right Arrow key.

     **IMPORTANT!** The online indicator beside a main disc listing indicates that the disc content is available in the path indicated within the tree. The offline indicator beside a main disc listing indicates that the disc content is not available in the path indicated within the tree (for example, when your computer has only one CD-ROM drive and the disc is not currently in the drive).

  4. Activate the Copy button.
     The Copy Options dialog box open.
5. Select the library disc by putting the focus on the disc listing then pressing the SPACEBAR.

6. Activate the OK button. The Browse for Folder dialog box opens.

7. In the Browse for Folder dialog box, browse to the desired target path for the library copy.

   **IMPORTANT!** The target path needn’t include library- or disc-specific subdirectories; Data Manager will automatically append the path so that it includes subdirectories specific to the library and disc(s) in question. For example, if you were copying the Bankruptcy library and browsed to a target path of \C:\LexisNexisCD\Data, Data Manager will add library- and disc-specific subdirectories such as \Bankrupt\Disk1\, making the final path \C:\LexisNexisCD\Data\Bankrupt\Disk1\.

8. In the Browse for Folder dialog box, activate the OK button. A Copying meter appears, indicating the progress of the copying process. When the meter closes, a message box appears, indicating that the library was successfully copied.

9. Activate the OK button to close the message box. Data Manager is fully revealed, and the disc listing is updated to reflect the path to which the disc contents were copied.

10. Activate the Save button in Data Manager. A message box opens, informing you that your changes have been saved.

11. Activate the OK button to close the message box.

12. Close Data Manager or perform additional data-management tasks, as applicable:

   • To close Data Manager, activate the Exit button.

   OR

   • To perform additional data-management tasks, follow the steps under the procedure for the given task(s).

   - **To copy a multi-disc library**

     1. Insert the first library CD into your computer’s CD-ROM drive.
Open Data Manager as outlined under “To access Data Manager,” on page 101.

Choose the desired library from the Please Select a Library drop-down field.
The pane below the drop-down field lists the discs comprising the selected library.

**Note:** The disc Path and Drive Info (i.e., path contents) are detailed under each main disc listing. If these specifics are not displayed, put the focus on the main disc listing then press the Right Arrow key.

**IMPORTANT!** The online indicator beside a main disc listing indicates that the disc content is available in the path indicated within the tree. The offline indicator beside a main disc listing indicates that the disc content is not available in the path indicated within the tree (for example, when your computer has only one CD-ROM drive and the disc is not currently in the drive).

Activate the **Copy** button.
The Copy Options dialog box opens.

For each disc that you want to copy, place the focus on the corresponding listing then press the **SPACEBAR** until a checkmark appears in the corresponding check box.

Activate the **OK** button.
The Browse for Folder dialog box opens.

In the Browse for Folder dialog box, browse to the desired target path for the library copy.

**IMPORTANT!** The target path needn’t include library- or disc-specific subdirectories; Data Manager will automatically append the path so that it includes subdirectories specific to the library and disc(s) in question. For example, if you were copying the Bankruptcy library and browsed to a target path of C:\LexisNexisCD\Data, Data Manager will add library- and disc-specific subdirectories such as \Bankrupt\Disk1, making the final path C:\LexisNexisCD\Data\Bankrupt\Disk1.

In the Browse for Folder dialog box, activate the **OK** button.
If the disc noted in the Browse for Folder dialog box is the last disc in the library, a Copying meter appears, indicating the progress of the copying process. When the meter closes, a message box appears, informing you to insert the next disc. Proceed to step 9.

OR

If the disc noted in the Browse for Folder dialog box is not the last disc in the library, a Browse for Folder dialog box opens for the next disc in the library. Repeat steps 7 and 8.

9 Remove the just-copied disc from the CD-ROM drive and insert the next disc to be copied.

10 Activate the OK button to close the message box.

A Copying meter appears, indicating the progress of the copying process. When the meter closes, one of the following happens:

• If the disc currently in the CD-ROM drive is the last disc in the multi-disc set, a message box appears, indicating that the library was successfully copied. Proceed to step 11.

OR

• If the disc currently in the CD-ROM drive is not the last disc in the multi-disc set, a message box appears, informing you to insert the next disc. Repeat steps 9 and 10.

Note: If you elect to halt the copying process by activating the Cancel button, all files associated with the disc currently in the CD-ROM drive are removed from the target location. All files associated with any disc copied earlier in the copying process, however, are left in place in the target location. Therefore, if you subsequently want to complete the process of copying the entire library, you need select for copying (at step 5, above) only the disc on which you initially halted the copying process along with any subsequent discs in the multi-disc set.

11 Activate the OK button to close the message box.

Data Manager is fully revealed, and the disc listings are updated to reflect the path to which the disc contents were copied.

12 Activate the Save button in Data Manager.
A message box opens, informing you that your changes have been saved.

13 Activate the OK button to close the message box.

14 Close Data Manager or perform additional data-management tasks, as applicable:
   • To close Data Manager, activate the Exit button.
   
   OR
   
   • To perform additional data-management tasks, follow the steps under the procedure for the given task(s).

Moving a Library Copy

Once you have copied a library, Data Manager allows you to move that copy. When you do so, the entire library is moved to a single location.

To move a library copy

1 Open Data Manager as outlined under “To access Data Manager,” on page 101.

2 Choose the desired library from the Please Select a Library drop-down field.

   The pane below the drop-down field lists the disc comprising the selected library.

   Note: The disc Path and Drive Info (i.e., path contents) are detailed under each main disc listing. If these specifics are not displayed, put the focus on the main disc listing then press the Right Arrow key.

   IMPORTANT! The online indicator beside a main disc listing indicates that the disc content is available in the path indicated within the tree. The offline indicator beside a main disc listing indicates that the disc content is not available in the path indicated within the tree (for example, when your computer has only one CD-ROM drive and the disc is not currently in the drive).

3 Activate the Move button.

LexisNexis CD User’s Guide
A dialog box opens, informing you that the previously copied discs will be moved to a common directory.

4 Choose **Yes** to proceed with the move.

**Tip:** To instead terminate the process without moving the library copy, choose **No**.

The Browse for Folder dialog box opens.

5 In the Browse for Folder dialog box, browse to the path to which you want to move the library copy.

**IMPORTANT!** The target path needn’t include library- or disc-specific subdirectories; Data Manager will automatically append the path so that it includes subdirectories specific to the library and disc(s) in question. For example, if you were moving a copy of the Bankruptcy library and browsed to a target path of **C:\LexisNexisCD\Data**, Data Manager will add library- and disc-specific subdirectories such as **Bankrupt\Disk1\**, making the final path **C:\LexisNexisCD\Data\Bankrupt\Disk1\**.

6 In the Browse for Folder dialog box, activate the **OK** button. A message box appears, informing you that the library was successfully moved.

7 Activate the **OK** button to close the message box.

Data Manager is fully revealed, with the disc listing(s) reflecting the path to which the library copy was moved.

8 Activate the **Save** button in Data Manager.

A message box opens, informing you that your changes have been saved.

9 Activate the **OK** button to close the message box.

10 Close Data Manager or perform additional data-management tasks, as applicable:

- To close Data Manager, activate the **Exit** button.

**OR**

- To perform additional data-management tasks, follow the steps under the procedure for the given task(s).
Deleting a Library Copy

Because your work environment may change over time necessitating removal of certain data from your system, Data Manager allows you to delete any library that you copied to a local drive or network location.

**IMPORTANT!** Built-in safeguards prevent you from deleting the library originals from CD. Note that once you have deleted a library copy, you cannot retrieve the copy and you must then use the Edit Path feature of Data Manager to indicate the valid location of the library (see “Editing the Path of a Library,” on page 109).

- **To delete a library copy**

  1. Open Data Manager as outlined under “To access Data Manager,” on page 101.
  2. Choose the desired library from the **Please Select a Library** drop-down field.
     The pane below the drop-down field lists the disc(s) comprising the selected library.

     **Note:** The disc Path and Drive Info (i.e., path contents) are detailed under each main disc listing. If these specifics are not displayed, put the focus on the main disc listing then press the Right Arrow key.

     **IMPORTANT!** The **online** indicator beside a main disc listing indicates that the disc content is available in the path indicated within the tree. The **offline** indicator beside a main disc listing indicates that the disc content is not available in the path indicated within the tree (for example, when your computer has only one CD-ROM drive and the disc is not currently in the drive).

  3. Activate the **Delete** button.
     A message is displayed, prompting you to confirm your desire to delete the selected library copy.
  4. Choose **Yes** to delete the selected library copy.
A status box appears, indicating the progress of the deletion process. When the status box closes, a message box appears, informing you that the library copy was successfully deleted and reminding you that you should now use Data Manager to indicate the valid location of the library.

5 Activate the OK button to close the message box.

Data Manager is fully revealed, and each disc listing for the library is updated to reflect the offline indicator and an unidentified path.

6 Activate the Save button in Data Manager.

A message box opens, informing you that your changes have been saved.

7 Activate the OK button to close the message box.

8 Close Data Manager or perform additional data-management tasks, as applicable:

   • To close Data Manager, activate the Exit button.

   OR

   • To perform additional data-management tasks, follow the steps under the procedure for the given task(s).

---

**IMPORTANT!** Once you have deleted a library copy, you cannot recover the copy. If you decide that you do not want to delete the library copy, choose No in this dialog box. Doing so will cancel the deletion process.

Note: Before you will be able to again access the library content, you must use the Edit Path feature of Data Manager to indicate the valid location of the library (see “Editing the Path of a Library,” on page 109).

---

**Editing the Path of a Library**

In certain situations, a library may be deleted or moved from its former location. For instance, after copying a library to your local drive, you may need to free up that space and decide to revert to accessing that library data from the CD. In such an instance, you would need to
instruct the *LexisNexis CD* application to look for the library on the CD-ROM drive. Data Manager allows for this via its Edit Path feature.

- **To edit the path of a library**
  1. Open Data Manager as outlined under “To access Data Manager,” on page 101.
  2. Choose the desired library from the Please Select a Library drop-down field.
     The pane below the drop-down field lists the discs comprising the selected library, with each disc for which the currently indicated path is not valid being indicated by the offline indicator.

    **Note:** The disc Path and Drive Info (i.e., path contents) are detailed under each main disc listing. If these specifics are not displayed, put the focus on the main disc listing then press the Right Arrow key.

  3. From the tree of the disc for which you want to edit the path, open the Browse for Folder dialog box by pressing ALT + D to open the Disc menu then choosing Edit Path.
  4. Browse to the new file path containing the disc content, then activate the OK button.
     Data Manager is fully revealed, and the disc listing is updated to reflect the edited path.

    **Note:** Assuming that you have edited the path to reflect the proper location of the disc content, the offline indicator will also have changed to the online indicator.

  5. Edit the paths of additional discs, as necessary:
     - To edit paths of additional discs, repeat steps 3 and 4.
     - OR
     - To continue without editing paths of additional discs, proceed to step 6.
  6. Activate the Save button in Data Manager.
     A message box opens, informing you that your changes have been saved.
  7. Activate the OK button to close the message box.
Managing Data, Rights, and Peripheral-Software Integration

8 Close Data Manager or perform additional data-management tasks, as applicable:
   • To close Data Manager, activate the **Exit** button.
   **OR**
   • To perform additional data-management tasks, follow the steps under the procedure for the given task(s).

Managing Library Access Rights

Because your practice may change over time, the *LexisNexis CD* application comes equipped with a tool allowing you to administer library access rights. Specifically, the Rights Manager utility lets you expand or abridge library access rights should you change your subscription after receiving and installing the latest release of a particular library on CD.

**Note:** Rights Manager is available only to standalone users and those network users set up as Administrator. Client users do not have access to Rights Manager.

- To update library access rights

   1 Open the **Start** menu in one of the following manners:
      • Press the **WINDOWS** LOGO key.
      **OR**
      • Press **CTRL** + **ESC**.
      **OR**
      • Activate the **Start** button, located on the taskbar in the lower-left corner of your Windows desktop.
   2 On the Start menu choose **Programs**.
   3 On the Programs menu choose **LexisNexis CD on Folio 4**.
   4 On the LexisNexis CD on Folio 4 menu choose **Rights Manager**. Rights Manager opens.
   5 From the **Library** drop-down list, choose the library for which you want to update your subscription.
      The selected library is highlighted.
6 In the Codeword text field, type the codeword you received for the selected library.

**Note:** The codeword is a series of 20 characters separated by hyphens. It can be found on the packing slip enclosed with the CD.

**Tip:** Do not type the hyphens between the characters of your codeword because the hyphens already appear as part of the text field.

7 Activate the Process button.
Your request is processed and the Products & Publications dialog box opens.

**Tip:** The Products & Publications dialog box shows all the products in the library. A folder icon beside a product title indicates that you have access rights to that product; a red “x” indicates that you do not have access rights.

8 Update additional library subscriptions or exit Rights Manager, as desired:
- To update additional library subscriptions, activate the Process Another button, then repeat steps 5 through 7.
  
  **OR**
  
  - To exit Rights Manager, activate the Finish button.

**Managing Peripheral-Software Integration**

Because your work environment—particularly, the type and installation location of software applications—may change over time, the *LexisNexis CD* application provides a quick and easy way to alert the program to such changes. A single utility accessed via the Program group allows you to indicate changes in word-processing and PDF-viewer software.
To access the Update Settings Utility

1. Open the Start menu in one of the following manners:
   - Press the WINDOWS LOGO key.
   - Press CTRL + ESC.
   - Activate the Start button, located on the taskbar in the lower-left corner of your Windows desktop.

2. On the Start menu choose Programs.
   The Update Settings Utility opens.

To update your PDF-viewer information

1. Open the Update Settings Utility as outlined under “To access the Update Settings Utility,” on page 113.

   Note: If a pdf viewer is already installed on your system, the Path to PDF Viewer field will already be populated.

2. In the PDF Viewer area, activate the Browse button.
   An Open dialog box appears.
3. Browse to the drive and directory to which the desired PDF-viewer software is installed, then select the executable (.exe) file for the software.
4. Activate the Open button.
   The Open dialog box closes, again revealing the Update Settings Utility now displaying the updated Path to PDF Viewer.
5. Activate the Update button.
   A Saved Settings dialog box opens, informing you that your change has been saved.
In the Saved Settings dialog box, activate the **OK** button. The dialog box closes, again revealing the Update Settings Utility.

7 Update your word-processing setting or exit the Update Settings Utility, as desired:

• To update your word-processor setting, follow the steps outlined under the corresponding procedure, beginning on page 114.

**OR**

• To exit the Update Settings Utility, activate the **Close** button.

To update your word-processor information

1 Open the Update Settings Utility as outlined under “To access the Update Settings Utility,” on page 113.

2 In the **Word Processor** area, activate the **Browse** button. An Open dialog box appears.

3 Browse to the drive and directory to which the desired word-processing software is installed, then select the executable (.exe) file for the software.

4 Activate the **Open** button. The Open dialog box closes, again revealing the Update Settings Utility now displaying the updated Path to Word Processor.

5 Activate the **Update** button.

---

**Note:** If you selected a viewer that doesn't meet the minimum requirements for ensuring full PDF-viewing functionality, you will instead receive a message box alerting you to this fact and prompting you to indicate whether you want to use the selected PDF viewer. In this case, do one of the following:

• To select another PDF viewer, choose **No** to close the message box and return to the Update Settings Utility, then repeat steps 2 through 5.

• To use the originally selected PDF viewer, choose **Yes** to close the message box and display the Saved Settings dialog box, then proceed to step 6. In this instance, note that you may not be able to view all PDF documents.
6 A Saved Settings dialog box opens, informing you that your change has been saved.

7 In the Saved Settings dialog box, activate the **OK** button.
The dialog box closes, again revealing the Update Settings Utility.

8 Update your PDF-viewer setting or exit the Update Settings Utility, as desired:
   • To update your PDF-viewer setting, follow the steps outlined under the corresponding procedure, beginning on page 113.
     **OR**
   • To exit the Update Settings Utility, activate **Close** button.
Appendix A  Working with the Program Interface

The program interface refers to what the *LexisNexis*® CD application displays on screen and where and how it displays it. Interface elements include things such as program menus, the toolbar, window areas, navigational aids, icons, and display font.

Working with the program interface requires an understanding of the following:

- Program menus
- Interface customizing options

This chapter outlines each of these topics and, where applicable, provides instructions for performing the given task.

**Understanding the Menus**

The *LexisNexis CD* application provides a number of menus containing options of four general types:

- Commands that provide access to a secondary mechanism where you indicate the specifics of carrying out a task and from which you then execute the task, such as the Print command on the File menu
- Commands that directly execute a task, such as the hit navigation commands (i.e., Next Hit, Previous Hit, Next Record Hit, Previous Record Hit) on the Search menu
- Independent settings that can be enabled and disabled regardless of other settings, such as the Show Check Boxes setting on the View menu
- Mutually exclusive settings that when enabled disable any alternative settings, such as the settings to display All Records, Records with Hits, Tagged Records, or Checked Branches on the View menu

*Note:* Whether electing an independent or a mutually exclusive setting, the results are immediately apparent.

Menu availability and form may vary depending on interface mode (i.e., the active part of the interface); option availability on the various
menus may vary depending on program mode [i.e., the most recent task performed and/or the file type (read-only or shadow) of the active publication].

The *LexisNexis CD* menu bar contains the following menus:
- File
- Edit (displayed only when the Document view is active)
- View
- Navigate
- Search
- Layout (displayed only when the Document view is active)
- Tools
- Window
- *LexisNexis*
- Help

**File Menu**

The File menu is always displayed.

Menu form varies slightly depending on interface mode, with the Export command being displayed only when the Document or Contents pane is active.

With the exception of the Save command (which is available only when working in a shadow file), all options are always available.

See Table A-1 for a summary of File menu options and corresponding purposes.

<table>
<thead>
<tr>
<th>Option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Create a shadow file of the active publication (see “Creating and Opening Shadow Files,” on page 91).</td>
</tr>
<tr>
<td>Open</td>
<td>Access an infobase or shadow file.</td>
</tr>
<tr>
<td>Close</td>
<td>Exit the active infobase or shadow file.</td>
</tr>
</tbody>
</table>
Edit Menu

The Edit menu is displayed only when the Document pane is active and allows for the copying of selected material from the active publication for purposes of pasting it elsewhere (see Table A-2).
View Menu

The View menu is always displayed but takes different forms depending on interface mode. Within each form of the View menu, certain options are available only following certain tasks.

View Menu, Document Mode

With the Document pane active, the View menu provides options for the following:

• Varying the type and amount of content displayed in the Document pane
• Refreshing the table of contents
• Adjusting the magnification of content displayed in all panes

Table A-3 summarizes the menu options and corresponding purposes.

Table A-3  View Menu (Document Mode) Summary

<table>
<thead>
<tr>
<th>Option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hidden</td>
<td>Display material specific to the production</td>
</tr>
<tr>
<td></td>
<td>of the active publication.</td>
</tr>
<tr>
<td></td>
<td>Note: By default, this setting is disabled.</td>
</tr>
<tr>
<td>Code</td>
<td>Display coding (e.g., hard and soft paragraph</td>
</tr>
<tr>
<td></td>
<td>returns) in publication content.</td>
</tr>
<tr>
<td></td>
<td>Note: By default, this setting is disabled.</td>
</tr>
</tbody>
</table>
With the Hit List pane active, the View menu provides options for the following:

---

**Table A-3  View Menu (Document Mode) Summary (Continued)**

<table>
<thead>
<tr>
<th>Option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display Settings</strong></td>
<td></td>
</tr>
<tr>
<td>All Records</td>
<td>Display all publication content.</td>
</tr>
<tr>
<td></td>
<td><em>Note:</em> This is the default display setting.</td>
</tr>
<tr>
<td>Records with Hits</td>
<td>Display only those records containing query matches.</td>
</tr>
<tr>
<td></td>
<td>(see “Limiting Content Displayed After a Search,” on page 70).</td>
</tr>
<tr>
<td></td>
<td><em>Note:</em> A record is defined as either a heading or one or more paragraphs of body text following a heading. Note that this setting is available only following a search.</td>
</tr>
<tr>
<td>Checked Branches</td>
<td>Display only that portion of publication content selected in the table of contents.</td>
</tr>
<tr>
<td></td>
<td>(see “Limiting Content Displayed for Viewing,” on page 19).</td>
</tr>
<tr>
<td></td>
<td><em>Note:</em> This setting is available only after you have selected content via the check boxes in the table of contents. Note that if you subsequently deselect all content in the table of contents, nothing will be displayed in the Document pane. To again display content, you must either select one or more entries in the table of contents or elect a different available display setting.</td>
</tr>
<tr>
<td>Synchronize Contents</td>
<td>Manually refresh the table of contents to reflect your location in publication content.</td>
</tr>
<tr>
<td></td>
<td>(see “Synchronizing the Table of Contents,” on page 20).</td>
</tr>
<tr>
<td>Zoom</td>
<td>Adjust the magnification at which text in all panes is displayed, from the default of 100% to a maximum of 500% or a minimum of 10%.</td>
</tr>
</tbody>
</table>

---

_view menu, hit list mode_

With the Hit List pane active, the View menu provides options for the following:
Varying the amount and type of information displayed in the hit list
Adjusting the magnification of content displayed in all panes.
Table A-4 summarizes the menu options and corresponding purposes.

Table A-4  View Menu (Hit List Mode) Summary

<table>
<thead>
<tr>
<th>Option</th>
<th>Purpose</th>
</tr>
</thead>
</table>
| Column Header   | Display or hide the bar containing column descriptor(s) at the top of the Hit List pane.  
                   | *Note:* By default, this setting is enabled.                               |
| Hit List Properties | Change the categories of information displayed in the hit list.          |
| Zoom            | Adjust the magnification at which text in all panes is displayed, from the default of 100% to a maximum of 500% or a minimum of 10%. |

View Menu, Contents Mode
With the Contents pane active, the View menu provides options for the following:
• Expanding or collapsing the table of contents in various increments
• Displaying or hiding selection check boxes in the table of contents
• Negating all selections made via the table of contents
• Adjusting the magnification of content displayed in all panes.
Table A-5 summarizes the menu options and corresponding purposes.

Table A-5  View Menu (Contents Mode) Summary

<table>
<thead>
<tr>
<th>Option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand One Level</td>
<td>Display the immediate sublevel of the level currently selected in the table of contents (see “To expand a level in the table of contents to the immediate sublevel,” on page 17).</td>
</tr>
</tbody>
</table>
### Table A-5  View Menu (Contents Mode) Summary (Continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand Branch</td>
<td>Display all sublevels of the level currently selected in the table of contents (see “To collapse a level in the table of contents,” on page 18).</td>
</tr>
<tr>
<td>Expand All</td>
<td>Display all levels in the table of contents (see “To fully expand the table of contents,” on page 18).</td>
</tr>
<tr>
<td>Collapse Branch</td>
<td>Hide all sublevels of the level currently selected in the table of contents (see “To collapse a level in the table of contents,” on page 18).</td>
</tr>
<tr>
<td></td>
<td>Note: This command is available only after you have expanded one or more levels in the table of contents.</td>
</tr>
</tbody>
</table>
| Expand to Level       | Expand or collapse the table of contents to a specified level.  
|                       | Tip: You can fully collapse the table of contents by selecting the upper-most level of the publication (see “To fully collapse the table of contents,” on page 18). |
| Show Check Boxes      | Display check boxes in the table of contents for purposes of narrowing a search or limiting the publication content shown in the Document pane (see “To search selected portions of the active publication,” on page 49, and “To limit content displayed for viewing,” on page 19).  |
|                       | Note: By default, this setting is enabled.                                                                                           |
| Clear All Checks      | Negate all selections made in the table of contents.                                                                                  |
| Zoom                  | Adjust the magnification at which text in all panes is displayed, from the default of 100% to a maximum of 500% or a minimum of 10%. |

### Navigate Menu

The Navigate menu is always displayed.
Menu form varies slightly depending on interface mode, with the Follow Link, Next Link, Prev Link commands being displayed only when the Document pane is active.

Program mode influences available options, as shown in Table A-6.
### Table A-6 Navigate Menu Summary

<table>
<thead>
<tr>
<th>Option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go Back</td>
<td>Return to the location from which you linked.</td>
</tr>
<tr>
<td></td>
<td><em>Note:</em> This command becomes available only after linking within or between publications.</td>
</tr>
<tr>
<td>Go Forward</td>
<td>Return to the most recent link destination.</td>
</tr>
<tr>
<td></td>
<td><em>Note:</em> This command becomes available only after linking within or between publications and returning to the location from which you linked.</td>
</tr>
<tr>
<td>Next Hit</td>
<td>Move the focus in the Document pane to the hit that immediately follows the currently highlighted hit in the currently displayed record.</td>
</tr>
<tr>
<td></td>
<td><em>Tip:</em> If there is no “next hit” within the currently displayed record, activating this button will move the focus to the first hit in the next record containing hits.</td>
</tr>
<tr>
<td></td>
<td><em>Note:</em> This command becomes available only following a search. If you navigate to the last hit in publication content, the command again becomes unavailable.</td>
</tr>
<tr>
<td>Previous Hit</td>
<td>Move the focus in the Document pane to the hit that immediately precedes the currently highlighted hit in the currently displayed record.</td>
</tr>
<tr>
<td></td>
<td><em>Tip:</em> If there is no “previous hit” within the currently displayed record, activating this button will move the focus to the last hit in the previous record containing hits.</td>
</tr>
<tr>
<td></td>
<td><em>Note:</em> This command is available only after you have run a search and navigated beyond the first hit in publication content. If you subsequently navigate back to the first hit, the command again becomes unavailable.</td>
</tr>
</tbody>
</table>
### Table A-6  Navigate Menu Summary (Continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Purpose</th>
</tr>
</thead>
</table>
| Next Record Hit  | Move the focus in the Document pane to the beginning of the first record that follows the currently displayed record and contains hits.  
*Note:* This command becomes available only following a search. If you navigate to the last record containing a hit, the command again becomes unavailable. |
| Previous Record Hit | Move the focus in the Document pane to the beginning of the first record that precedes the currently displayed record and contains hits.  
*Tip:* If the focus is currently on the first hit in publication content and you execute this command, the focus will move to the beginning of the record containing the first hit.  
*Note:* This command becomes available only following a search. |
| Follow Link      | Display the content referenced in the link currently in focus.  
*Note:* This command becomes available only when the focus is in the Document pane and the cursor is positioned just before a link. |
| Next Link        | Move the focus to the next link appearing in the currently displayed record or, if no additional links exist in the currently displayed record, move the focus to the beginning of the next record in document content.  
*Note:* This command becomes available only when the focus is in the Document pane. |
| Prev Link        | Move the focus to the previous link appearing in the currently displayed record or, if no additional links exist in the currently displayed record, move the focus to the end of the previous record in document content.  
*Note:* This command becomes available only when the focus is in the Document pane. |
Search Menu

The Search menu is always displayed.

Menu form varies slightly depending on interface mode, with the Go To command being displayed only when the Document pane is active. Program mode influences available options, as shown in Table A-7.

<table>
<thead>
<tr>
<th>Option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query</td>
<td>Run a natural language search using the Query dialog box (see “Query Dialog Box,” on page 33 and “Understanding Natural Language Searching,” on page 45).</td>
</tr>
<tr>
<td>Advanced Query</td>
<td>Run a Boolean-based search using the Advanced Query window (see “Advanced Query Window,” on page 29).</td>
</tr>
</tbody>
</table>
Layout Menu

The Layout menu is displayed only when the Document pane is active. Most menu options are available only when working within notes posted to a shadow file (see Table A-8 for details).

Table A-8  Layout Menu Summary

<table>
<thead>
<tr>
<th>Option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font</td>
<td>Modify font settings (e.g., family, size, color) for text currently selected in publication content. Note: This command is available only when working in a note posted to a shadow file.</td>
</tr>
</tbody>
</table>
The Tools menu is always available but takes two different forms depending on interface mode.

**Tools Menu, Contents or Hit List Mode**

With the Contents or Hit List pane active, the Tools menu provides options for customizing the interface and setting program preferences. These options are always available.

Table A-9 summarizes the menu options and corresponding purposes.

<table>
<thead>
<tr>
<th>Option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paragraph</td>
<td>Modify settings (e.g., alignment, indentation, space above) for the active paragraph(s) in publication content.</td>
</tr>
<tr>
<td></td>
<td><em>Note:</em> This command is available only when working in a note posted to a shadow file.</td>
</tr>
<tr>
<td>Tabs</td>
<td>Modify tab settings for the active paragraph(s) in publication content.</td>
</tr>
<tr>
<td></td>
<td><em>Note:</em> This command is available only when working in a note posted to a shadow file.</td>
</tr>
<tr>
<td>Borders</td>
<td>Modify border settings for the active paragraph(s) in publication content.</td>
</tr>
<tr>
<td></td>
<td><em>Note:</em> This command is available only when working in a note posted to a shadow file.</td>
</tr>
<tr>
<td>Style</td>
<td>Format selected publication content by applying a style; also, create new or modify or delete existing styles used to format publication content.</td>
</tr>
<tr>
<td></td>
<td><em>Note:</em> This command is available only when working in a note posted to a shadow file.</td>
</tr>
<tr>
<td>Text Properties</td>
<td>View formatting and level information for the paragraph in which the cursor is currently placed in publication content.</td>
</tr>
</tbody>
</table>
Tools Menu, Document Mode

With the Document pane active, the Tools menu provides options for customizing the interface and setting program preferences as well as for customizing content in shadow files.

Certain menu options are available only when working in a shadow file or following given tasks (see Table A-10 for details).

Table A-10  Tools Menu (Document Mode) Summary

<table>
<thead>
<tr>
<th>Option</th>
<th>Purpose</th>
</tr>
</thead>
</table>
| **Bookmark** | Insert in publication content a named destination for purposes of quickly finding relevant material (see “Bookmarking Content in Shadow Files,” on page 94).  
**Note:** This command is functional only when working in a shadow file. |
| **Highlighter** | Visually enhance material in publication content for purposes of calling attention to that material; also, create new or modify or delete existing highlighting schemes (see “Highlighting Content in Shadow Files,” on page 96).  
**Note:** This command is available only when working in a shadow file. |
Window Menu

The Window menu is always displayed and all options on the menu are always available.

See Table A-11 for a summary of Window menu options and corresponding purposes.

Table A-10  Tools Menu (Document Mode) Summary (Continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note</td>
<td>Annotate individual paragraphs in publication content (see “Annotating Content in Shadow Files,” on page 92).</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This command is available only when working in a shadow file.</td>
</tr>
<tr>
<td>Remove Highlighter</td>
<td>Clear highlighting from publication content (see “Highlighting Content in Shadow Files,” on page 96).</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This command becomes available only after you have applied a highlighter to content in a shadow file.</td>
</tr>
<tr>
<td>Remove Note</td>
<td>Delete an annotation from publication content (see “Annotating Content in Shadow Files,” on page 92).</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This command becomes available only after you have annotated content in a shadow file.</td>
</tr>
<tr>
<td>Customize</td>
<td>Configure menus and toolbar(s) and/or define keyboard shortcuts.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You cannot customize the main toolbar.</td>
</tr>
<tr>
<td>Options</td>
<td>Set program and interface preferences (see “Setting Program Preferences,” on page 14, and “Customizing the Interface,” on page 135).</td>
</tr>
</tbody>
</table>
LexisNexis Menu

The LexisNexis menu is always displayed, with the exception of the Case Update command (which is available only following a search of a publication containing case material), all menu options are always available.

See Table A-13 for a summary of LexisNexis menu options and corresponding purposes.

Table A-11 Window Menu Summary

<table>
<thead>
<tr>
<th>Option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cascade</td>
<td>Arrange all open windows so that they overlap diagonally starting from the upper-left corner of the monitor screen and descending toward the lower-right corner, with only the active window fully visible.</td>
</tr>
<tr>
<td>Tile Vertically</td>
<td>Arrange all open windows so that they appear side by side, with each fully visible but proportionately reduced in size horizontally.</td>
</tr>
<tr>
<td>Tile Horizontally</td>
<td>Arrange all open windows so that they appear one on top of another, with each fully visible but proportionately reduced in size vertically.</td>
</tr>
<tr>
<td>Arrange Icons</td>
<td>After minimizing all open publications and manually arranging the corresponding icons, automatically align all icons in an orderly fashion along the bottom of the interface.</td>
</tr>
<tr>
<td>Close All</td>
<td>Exit all open publications.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Update the active window to reflect the most recent action performed.</td>
</tr>
<tr>
<td>List of open publications</td>
<td>Activate the window corresponding to an open publication.</td>
</tr>
</tbody>
</table>

LexisNexis CD User’s Guide
Table A-12  LexisNexis Menu Summary

<table>
<thead>
<tr>
<th>Option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Selector</td>
<td>Open one or more publications (see “Opening a Publication,” on page 8).</td>
</tr>
</tbody>
</table>
| Case Update     | Link to the lexis.com online research system and re-run the most recently performed search of a case collection against any cases added to the collection since the most recent CD release (see “Searching Updated Case Content on the lexis.com Service,” on page 62).  
  *Tip:* This command becomes available only after running a search. |
| Check a Citation| Validate research via the online Shepard’s® Citations Service on the lexis.com® research system.  
  *Note:* You must be a subscriber to the Shepard’s Citations Service in order to use this feature. |
| Data Manager    | Copy libraries to a local or network drive, move library copies from one location to another, delete library copies, and/or instruct the program to look in the correct location when libraries have been moved from the most recently verified location (see “Managing Library Data,” on page 101).  
  *Note:* This command is available only to standalone users or to those network users set up as Administrator. |
| Rights Manager  | Initiate access to any products to which you subscribed subsequent to installing the most recent CD release of the corresponding library (see “Managing Library Access Rights,” on page 111).  
  *Note:* This command is available only to standalone users or to those network users set up as Administrator. |
Help Menu

The Help menu is always displayed and all options on the menu are always available.

See Table A-13 for a summary of Help menu commands and corresponding purposes.

---

**Table A-12  LexisNexis Menu Summary (Continued)**

<table>
<thead>
<tr>
<th>Option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Settings Utility</td>
<td>Alert the program when you change word-processing and/or pdf-viewer software (see “Managing Peripheral-Software Integration,” on page 112).</td>
</tr>
<tr>
<td><a href="http://www.lexis.com">www.lexis.com</a></td>
<td>Link directly to the <em>lexis.com</em> service, where subscribers can take advantage of numerous case-finding and analysis tools.</td>
</tr>
<tr>
<td>LexisNexis Matthew Bender</td>
<td>Link directly to the Matthew Bender home page on the LexisNexis Web site.</td>
</tr>
<tr>
<td>LexisNexis Bookstore</td>
<td>Link directly to the product offerings area of the LexisNexis Web site.</td>
</tr>
<tr>
<td>Accessibility Mode</td>
<td>For visually impaired users, set the program to run in a way that accommodates screen-reader software usage to the greatest extent possible.</td>
</tr>
</tbody>
</table>

**IMPORTANT!** Changing between operation modes after the program has been installed requires a reboot and will result in the resetting of program preferences to their default values. If you previously adjusted your program preferences and want to continue using those preferences, you will have to again manually adjust them accordingly.

**Tip:** When accessibility mode is enabled, a checkmark is displayed beside this option.
Customizing the Interface

To help meet your specific needs, the *LexisNexis CD* application lets you customize certain aspects of the interface, including the following:

- Current view
- Arrangement of all open windows

### Changing Your Current View

To accommodate the varied tasks that you may perform at any given time, the *LexisNexis CD* application offers a number of view options along with a quick and easy way of changing your view at any time.

Once you change your view setting, the program will remember your preference until the next time you change it.

**Note:** For detailed descriptions of view options, see "Understanding the Main Window," on page 12.

- To change your current view
  - Press the **F7** key until the desired view is displayed.
  - OR
  - From the *Navigate* menu choose **Next View** or **Prev View** until the desired view is displayed.
Arranging Windows

Because you may at times have more than one publication open, the LexisNexis CD application offers flexibility in the display and placement of open windows.

- To arrange windows

  With more than one publication open, activate the Window menu then choose one of the following options:
  - **Cascade** — to arrange all open windows so that they overlap diagonally starting from the upper-left corner of the monitor screen and descending toward the lower-right corner, with only the active window fully visible
  - **Tile Vertically** — to arrange all open windows so that they appear side by side, with each fully visible but proportionately reduced in size horizontally
  - **Tile Horizontally** — to arrange all open windows so that they appear one on top of another, with each fully visible but proportionately reduced in size vertically.

**Note:** For detailed descriptions of view options, see “Understanding the Main Window,” on page 12.
Appendix B  Working with Query Templates

The LexisNexis® CD application offers a number of query templates, allowing you to craft searches focusing on specific structural elements (e.g., levels, fields, and groups) within given types of content (e.g., analysis, code, and case). In this way, you can easily hone a search without having to know the underlying syntax.

While available query templates vary depending on the specific publication, some of the most common categories of query templates are as follows:

- Analysis
- Case
- Code
- Forms
- Indexes

Analysis Query Template

The Analysis query template allows you to find relevant discussions of a subject by searching the title and/or the body of analytical documents for specified search criteria.

The query template contains two fields:
- Search Chapter Titles for the word(s) below
- Search Chapters for the word(s) below

These fields can be used together or separately. When used together, the first field takes precedence, meaning that the program will first find all chapters having titles containing the search criteria entered in the first field and will then search the body of only those chapters for the search criteria entered in the second field, finally returning only those analytical documents matching the search criteria you entered in both fields.

When searching for information using this query template, follow these general guidelines:
- Use the first field alone to go to a specific chapter.
Use the second field alone to find chapters relating to a specified topic.
Use the fields together to find a specified topic within a specific chapter.

Case Query Templates

The *LexisNexis CD* application provides a number of query templates for use in searching case collections, including the following:
• Case Search
• Go To Case
• Judges
• Page Finder

Case Search Query Template

The Case Search query template would most commonly be used to find cases related to a specified topic.

To search for cases based on topic
1. Open the case collection that you want to search. (For instructions on opening a publication, see “Opening a Publication,” on page 8.)

   **Tip:** You can elect to limit your search to only selected portions of the case collection (e.g., courts, years). To do so, you must indicate those portions in the table of contents before opening the query template. For further details, see “Searching Selected Divisions of the Active Publication,” on page 49.

2. Open the query template by pressing ALT + S to activate the Search menu then choosing Case Search from the bottom of the menu.
   The Case Search query template opens.
3. In the **Key Word(s)** field, enter one or more query terms related to the topic for which you want to find related cases.
4. Activate the **OK** button.
The application searches for the specified query in the body of all cases (or all cases in the selected subset) in the active case collection.

**Go To Case Query Template**

The Go To Case query template is used to go to a case for which you have some identifying information.

**Search Hint:** Please note the in order to find an exact match when searching by party names or by a docket number that includes punctuation, you must enclose the search criteria in quotation marks (e.g., “CIV.A.90-1380-T”); note that you need not enclose citations in quotation marks (e.g., 517 U.S. 44).

- To go to a known case
  1. Open the case collection that you want to search. (For instructions on opening a publication, see “Opening a Publication,” on page 8.)

**Tip:** You can elect to limit your search to only selected portions of the case collection (e.g., courts, years). To do so, you must indicate those portions in the table of contents before opening the query template. For further details, see “Searching Selected Divisions of the Active Publication,” on page 49.

  2. Open the query template by pressing **ALT + S** to activate the **Search** menu then choosing **Go To Case** from the bottom of the menu.

  The Go To Case query template opens.

  3. In the desired query input field(s), enter corresponding information.
Activate the OK button.
The application searches for the specified term(s) in the heading of all cases (or all cases in the selected subset) in the active case collection.

Judges Query Template

The Judges query template is used to find cases heard by a particular judge.

To find cases heard by a particular judge

1. Open the case collection that you want to search. (For instructions on opening a publication, see “Opening a Publication,” on page 8.)

2. Open the query template by pressing ALT + S to activate the Search menu then choosing Judges from the bottom of the menu.

3. In the Case(s) Heard By, Opinion By, Concur By, or Dissent By field(s), type desired judge name(s).

Search Hints: Please note the following with regard to this query template:
- If searching by party name, note that such a search may return more than one result if by chance the specified names are duplicated across cases.
- To ensure finding an exact match when searching by party names or by a docket number that includes punctuation, enclose the search criteria in quotation marks (e.g., “CIV.A.90-1380-T”); note that you need not enclose citations in quotation marks (e.g., 517 U.S. 44).

Tip: You can elect to limit your search to only selected portions of the case collection (e.g., courts, years). To do so, you must indicate those portions in the table of contents before opening the query template. For further details, see “Searching Selected Divisions of the Active Publication,” on page 49.
Activate the OK button.
The application searches for the specified judge name(s) in the specified capacity in all cases (or all cases in the selected subset) in the active case collection.

Page Finder Query Template

The Page Finder query template is used to go directly to a specific pinpoint page within a case.

**Search Hint:** You must use correct punctuation and spaces when entering a pinpoint page number (e.g., 115 L. Ed. 2d 105), but you need not enclose the number in quotation marks. For purposes of this query template, construct the pinpoint page cite as follows: Volume Number, Reporter Abbreviation, Pinpoint Page Number. Note that you should not include the initial page number.

- To go to a pinpoint page number within a case
  1. Open the case collection that you want to search. (For instructions on opening a publication, see “Opening a Publication,” on page 8.)

**Tip:** You can elect to limit your search to only selected portions of the case collection (e.g., courts, years). To do so, you must indicate those portions in the table of contents before opening the query template. For further details, see “Searching Selected Divisions of the Active Publication,” on page 49.

  2. Open the query template by pressing ALT + S to activate the Search menu then choosing Page Finder from the bottom of the menu.

The Page Finder query template opens.

  3. Complete the query input field.
Activate the OK button.
The application searches for the specified pinpoint page number in all cases (or all cases in the selected subset) in the active case collection.

Code Query Template

The Code query template allows you to quickly go to a specific code section or to find code sections relating to a specific topic.

The template contains two search fields:
• Go to the following Section Number
• Search Code Sections for the following word(s)

These fields can be used together or separately. When used together, the first field takes precedence, meaning that the program will first find all code sections having titles containing the search criteria entered in the first field and will then search the body of only those sections for the search criteria entered in the second field, finally returning as search results only those records matching the search criteria you entered in both fields.

When searching for information using this query template, follow these general guidelines:
• Use the first field alone to go to a specific code section.
• Use the second field alone to find code sections relating to a specified topic.

Search Hint: If you are searching for a code section by number and that number contains punctuation, be sure to enclose your search criteria in quotation marks (e.g., “20:33”).
Common search scenarios for which you may use the Code query template are highlighted in the procedures following.

› **To go to a specific code section**

1. Open the publication that you want to search. (For instructions on opening a publication, see “Opening a Publication,” on page 8.)

   *Tip:* You can elect to limit your search to only selected components of the publication. To do so, you must indicate those components in the table of contents before opening the query template. For further details, see “Searching Selected Divisions of the Active Publication,” on page 49.

2. Open the query template by pressing ALT + S to activate the Search menu then choosing Code from the bottom of the menu. The Code query template opens.

3. In the **Go to the following Section Number** field, enter the desired section number.

   *Search Hints:* Please note the following with regard to this field:
   - Enter only the code section number, as opposed to the full cite. For example, if searching for 11 U.S.C. 362, you would enter “362”; note, however, that you should also select in the table of contents the heading that contains title 11 of the United States Code.
   - If the code section number contains punctuation, be sure to enclose it in quotation marks (e.g., “20:33”).

4. Activate the **OK** button.

   The application searches for the specified number in the headings of all sections (or all sections in the selected subset) in the active publication.

› **To find a code by topic**

1. Open the publication that you want to search. (For instructions on opening a publication, see “Opening a Publication,” on page 8.)
2 Open the query template by pressing ALT + S to activate the Search menu then choosing Code from the bottom of the menu.

The Code query template opens.

3 In the Search Code Sections for the following word(s) field, type the desired query. (See Chapter 6, “Formulating a Query” for details on crafting search criteria.)

4 Activate the OK button.

The application searches for the specified query in the body of all code sections (or all code sections in the selected subset) in the active publication.

Forms Query Template

The Forms query template allows you to go to a specific form by focusing on actual form numbers or titles or to find forms relating to a specified topic by searching for words or phrases within the forms themselves.

Search Hint: If you are searching for a form by number and that number contains punctuation, be sure to enclose your search criteria in quotation marks (e.g., “20:33”).

Common search scenarios for which you may use the Forms query template are highlighted in the procedures following.

› To go to a specific form

1 Open the publication that you want to search. (For instructions on opening a publication, see “Opening a Publication,” on page 8.)
2 Open the query template by pressing Alt + S to activate the Search menu then choosing Forms from the bottom of the menu.

The Forms query template opens.

3 In the Search Form Titles for word(s) below field, type the specific form number and/or word(s) from the form title.

**Search Hint:** If the form number contains punctuation, be sure to enclose it in quotation marks (e.g., “20:33”).

4 Activate the OK button.

The application searches for the specified form number or title in the title of all forms (or all forms in the selected subset) in the active publication.

To find forms by topic

1 Open the publication that you want to search. (For instructions on opening a publication, see “Opening a Publication,” on page 8.)

**Tip:** You can elect to limit your search to only selected components of the publication. To do so, you must indicate those components in the table of contents before opening the query template. For further details, see “Searching Selected Divisions of the Active Publication,” on page 49.

2 Open the query template by pressing Alt + S to activate the Search menu then choosing Forms from the bottom of the menu.

The Forms query template opens.

3 In the Search Forms for the word(s) below field, type the desired query. (See Chapter 6, “Formulating a Query,” for details on crafting search criteria.)
Activate the **OK** button.
The application searches for the specified query in the body of all forms (or all forms in the selected subset) in the active publication.

**Guided Search Query Template**

The Guided Search query template allows you to find specified topics by searching either the main headings or all entries in an index publication.

A common search scenario for which you may use the Guided Search query template is highlighted in the procedure following.

- **To find a specified topic in an index**
  1. Open the index publication that you want to search. (For instructions on opening a publication, see “Opening a Publication,” on page 8.)

     **Tip**: You can elect to limit your search to only selected components of the publication. To do so, you must indicate those components in the table of contents before opening the query template. For further details, see “Searching Selected Divisions of the Active Publication,” on page 49.

  2. Open the query template by pressing **ALT + S** to activate the **Search** menu then choosing **Guided Search** from the bottom of the menu.

     The Guided Search query template opens.

  3. In the applicable input field(s), type the desired query. (See Chapter 6, “Formulating a Query,” for details on crafting search criteria.)

  4. Activate the **OK** button.

     The application searches for the specified query in the main headings and/or all entries in the active publication or selected subset of the active publication.
Index

A
Advanced Query feature 127
Advanced Query window described 29
All Records command 121
Analysis query template described 137
Apply to All button 55
Arrange Icons command 132
arrow keys 24
autosynchronization
  of Document pane 27
  of table of contents 20

B
Bookmark feature 94, 130
Boolean-based connectors 40
Border feature 129
buttons
  hit navigation 68, 69
  lexis.com® 89

C
Cascade command 132
Cascade feature 136
Case query templates 138
Case Search query template described 138
Case Update feature 62, 133
cases (continued)
  searching updated on lexis.com service 62
Check a Citation feature 133
check boxes, showing in table of contents 20, 50, 75
Checked Branches command 19, 121
citations, checking 85
Clear All Checks feature 123
Clear Query command 57, 128
clearing a search 57
Close All command 132
Code command 120
Code query template described 142
codes
  finding by topic 143
  going to a specific section 143
Collapse Branch command 18, 123
Column Header command 122
connectors
  Boolean-based 40
  default processing order of, overriding 41
  default processing order of, understanding 41
  natural language 47
content
  copying and pasting from active publication 81
displaying again after displaying limited 20
exporting selected divisions in active publication 83
exporting that selected in active publication 82
Index

content (continued)
  limiting that displayed for viewing 19
  printing selected 74
  printing selected divisions of 74
  printing specified records of 76
  selecting that to be searched 49
  specifying that displayed after a search 70
  viewing from hit list 67
  viewing from table of contents 18
Content Selector 133
  displaying unowned publications in 8, 10
Content Selector feature 8
Contents feature 135
  copying
    content from active publication 81
    library from CD 102
copyright information
  viewing for Folio® Views software 135
  viewing for LexisNexis® CD application 135
criteria for search, formulating 37
Customize feature 130, 131
  customizing
    interface 135

D
Data Manager
  described 101, 133
  starting 101
deleting library copies 108
displaying
  panes 135
  table of contents, full window 15
  table of contents, partial window 15
Document pane
  autosynchronizing 27

Document pane (continued)
  changes to after a search 65
  described 24

E
Edit menu 119
  editing
    a search 59
    path of a library 109
  exiting the LexisNexis CD application 14
Expand All command 18, 123
Expand Branch command 17, 123
Expand One Level command 17, 122
Expand to Level command 18, 123
Export feature 81, 119
  exporting
    selected divisions of publication content 83
    selected publication content 82

F
File menu 118
Find Infobases feature 55, 119
Folio Views software, viewing copyright and version information for 135
Follow Link command 126
Font feature 128
footnotes
  described 26
  returning from 26
  viewing 26
forms
  finding by topic 145
  going to a specific 144
Forms query template
  described 144

LexisNexis CD User’s Guide
<table>
<thead>
<tr>
<th>G</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go Back command 25, 125</td>
<td>Indexes query template described 146</td>
</tr>
<tr>
<td>Go Forward command 125</td>
<td>indexes, finding a specific topic in 146</td>
</tr>
<tr>
<td>Go To Case query template described 139</td>
<td>infobase, defined 5</td>
</tr>
<tr>
<td>Guided Search query template described 146</td>
<td>interface, customizing 135</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>H</th>
<th>J</th>
</tr>
</thead>
<tbody>
<tr>
<td>Headings with Hits feature 67 help</td>
<td>Judges query template described 140</td>
</tr>
<tr>
<td>for LexisNexis CD application, finding 4, 135 for Windows, finding 3</td>
<td></td>
</tr>
<tr>
<td>Help menu 134</td>
<td></td>
</tr>
<tr>
<td>Hidden command 120</td>
<td></td>
</tr>
<tr>
<td>hiding</td>
<td></td>
</tr>
<tr>
<td>check boxes in table of contents 20, 50, 75</td>
<td></td>
</tr>
<tr>
<td>Highlighter feature 96, 130 hit list</td>
<td></td>
</tr>
<tr>
<td>described 66</td>
<td></td>
</tr>
<tr>
<td>printing partial 77</td>
<td></td>
</tr>
<tr>
<td>viewing content from 67</td>
<td></td>
</tr>
<tr>
<td>Hit List pane 65</td>
<td></td>
</tr>
<tr>
<td>Hit List Properties feature 122 hit(s)</td>
<td></td>
</tr>
<tr>
<td>defined 6</td>
<td></td>
</tr>
<tr>
<td>displaying only headings with in table of contents 67</td>
<td></td>
</tr>
<tr>
<td>moving to next record containing 69, 70</td>
<td></td>
</tr>
<tr>
<td>moving to next within a record 68, 69</td>
<td></td>
</tr>
<tr>
<td>moving to previous record containing 69, 70</td>
<td></td>
</tr>
<tr>
<td>moving to previous within a record 68, 69</td>
<td></td>
</tr>
<tr>
<td>navigating 68</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>L</th>
</tr>
</thead>
<tbody>
<tr>
<td>launching</td>
</tr>
<tr>
<td>Data Manager 101</td>
</tr>
<tr>
<td>LexisNexis CD application 6</td>
</tr>
<tr>
<td>Rights Manager 111</td>
</tr>
<tr>
<td>Update Settings Utility 113</td>
</tr>
<tr>
<td>Layout menu 128</td>
</tr>
<tr>
<td>lexis.com feature 89</td>
</tr>
<tr>
<td>lexis.com service linking to 89</td>
</tr>
<tr>
<td>linking to updated case material on 62</td>
</tr>
<tr>
<td>LexisNexis Bookstore command 134</td>
</tr>
<tr>
<td>LexisNexis CD application copyright and version information for, viewing 135</td>
</tr>
<tr>
<td>exiting 14</td>
</tr>
<tr>
<td>help for, finding 4, 135</td>
</tr>
<tr>
<td>key terms related to 5</td>
</tr>
<tr>
<td>main window of 12</td>
</tr>
<tr>
<td>menus in 117</td>
</tr>
<tr>
<td>online knowledge base for, viewing 135</td>
</tr>
</tbody>
</table>
LexisNexis CD application (continued)
preferences, setting for 14
starting 6
technical support for, contacting 4
LexisNexis Matthew Bender command 134
LexisNexis menu 132
library
copying from CD 102
defined 5
deleting a copy of 108
editing the path of 109
moving copies of 106
updating subscription 111
limiting
content displayed after a search 70
content displayed outside a search 19
link(s)
defined 6
described 25
following 25
returning from 25

M
main window
described 12
menus 117
menus (specific)
Edit 119
File 118
Help 134
Layout 128
LexisNexis 132
Navigate 123
Search 127
Tools 129
View 120
Window 131

moving
among hits 68
library copies 106

N
Narrowed View after Each Query
feature 70
narrowing
display of content after a search 70
display of content outside a search 19
natural language connectors 47
Navigate menu 123
navigation aids
arrow keys 24
links 25
Next Hit 68, 69
Next Record Hit 69, 70
Previous Hit 68, 69
Previous Record Hit 69, 70
Next Hit command 68, 69, 125
Next Link command 126
Next Pane command 127
Next Record Hit command 69, 70, 126
Next View command 127
Note feature 92, 131

O
online knowledge base, viewing for the
LexisNexis CD application 135
opening
Data Manager 101
LexisNexis CD application 6
publications 8
Rights Manager 111
Update Settings Utility 113
options. See preferences
ordered proximity search 43
overriding default connector processing
order 41
Index 151

P
Page Finder query template described 141
panes
displaying 135
panes (specific)
  Document 24, 65
  Hit List 65
  Reference 24
Paragraph feature 129
pasting content copied from active publication 81
path, editing for a library 109
PDF viewer, indicating preferred 113
phrase search 42
preferences
  setting for printing 79
  setting for program 14
preferences (specific)
  automatic synchronization of
    Document pane 27
  automatic synchronization of table of contents 20
PDF viewer 113
table of contents displaying headings with hits 67
word-processing application 114
Prev Link command 126
Prev Pane command 127
Prev View command 127
Previous Hit button 69
Previous Hit command 68, 69, 125
Previous Record Hit command 69, 70, 126
printing (continued)
  publication content, specified records 76
  selected publication content 74
  setting preferences for 79
  table of contents entries for specified records 77
product(s)
  defined 5
  initiating rights to additional 111
professional responsibility 4
program preferences, setting 14
program preferences, specific. See preferences (specific)
proximity search
described 42
ordered 43
unordered 43
publication(s)
copying and pasting content from active 81
defined 5
displaying unowned in Content Selector 8, 10
exporting content selected in 82
exporting selected divisions of 83
opening 8
printing content selected in 74
printing selected divisions of 74
printing specified records of 76
searching all in given directory 55
searching all open 54
searching selected portions of 49
searching structural elements (scopes) in 51
updating list of in Content Selector to reflect current availability 8, 9
Q
Query dialog box  
described 33
Query feature 33, 127
query results. See hit(s)
query template(s)  
defined 6
described 31, 137
query templates (specific)  
Analysis 137
Case Search 138
Code 142
Forms 144
Go To Case 139
Guided Search 146
Indexes 146
Judges 140
Page Finder 141
query, defined 6
query. See search(es)
 quitting the LexisNexis CD application  
14

R
record(s)  
defined 6
 moving to next containing hits 69, 70
 moving to next hit within 68, 69
 moving to previous containing hits 
 69, 70
 moving to previous hit within 68, 69
 printing specified 76
 printing table of contents entries for 
 specified 77
 viewing from hit list 67
Records with Hits command 121
Reference pane  
described 24
 viewing complete information in 24
Refresh button (in Content Selector) 8, 9
Refresh command 132
refreshing table of contents manually 22
relevancy, criteria used for determining 
of search results 47
Remove Highlight command 131
Remove Highlighter command 98
Remove Note command 131
Remove Note feature 94
rerunning a previous search 57, 58
responsibility, professional 4
Rights Manager  
described 133
 using 111
rights, initiating for additional products  
111

S
scope search 51
search mechanisms 29
search mechanisms (specific)  
Advanced Query window 29
Query dialog box 33
query templates 31, 137
Search menu 127
search results, criteria used in 
determining relevancy when 
using Query dialog box 47
search(es)  
clearing 57
 editing 59
 for a specific word 37
 for phrases 42
 for word variations 38
 for words in relationship 39
formulating criteria for 37
of all open publications 54
of all publications in a given 
directory 55
search(es) (continued)
  of selected portions of active publication 49
  of structural elements (scopes) in publications 51
  proximity, general 42
  proximity, ordered 43
  proximity, unordered 43
  rerunning a previous 57, 58
  specifying content to be displayed after 70
  viewing history of 57, 58
Shepard’s® Citations Service 85
  See also citations, checking shortcuts, keyboard
    for basic program tasks 11
  Show Check Boxes command 123
  Show Check Boxes feature 50
  Show Checked Branches feature 19
  Show History feature 57, 58, 128
  showing
    check boxes in table of contents 20, 50, 75
starting
  Data Manager 101
  LexisNexis CD application 6
  Rights Manager 111
  Update Settings Utility 113
  Style feature 129
supplements
  returning from 27
  viewing 26
  support, technical 4
  Synchronize Contents command 20, 121
synchronizing table of contents
  manually 22

T
  Tab feature 129

table of contents
  autosynchronizing Document pane to 27
  autosynchronizing to Document pane 20
  browsing 17, 18
  collapsing a level in 18
  collapsing fully 18
  displaying full-window 15
  displaying only headings with hits in 67
  displaying partial-window 15
  expanding a level fully in 17
  expanding fully 18
  expanding level to next sublevel in 17
  hierarchy of 16
  limiting content displayed using 19
  narrowing a search using 49
  printing entries for specified records 77
  refreshing manually 22
  showing check boxes in 20, 50, 75
  synchronizing manually 22
  uses for 16
  viewing content from 18
  viewing full text in 19
  viewing query results using 67
technical support, contacting 4
  Text Properties feature 129
  Tile Horizontally command 132
  Tile Horizontally feature 136
  Tile vertically command 132
  Tile Vertically feature 136
  Tools menu 129

U
  unordered proximity search 43
  Update Settings Utility
    described 112, 134
Update Settings Utility (continued) starting 113

V
version information
viewing for Folio Views software 135
viewing for LexisNexis CD application 135
View menu 120
view, changing 135
viewing
complete information in Reference pane 24
content from hit list 67
content from table of contents 18
footnotes 26
full text in table of contents 19
query results using the table of contents 67
viewing (continued)
search history 57, 58
supplements 26

W
wildcards 38
Window menu 131
windows, arranging all open 136
Word Wheel 30, 32, 44, 54
word(s)
  searching for a specific 37
  searching for in relationship to other words 39
  searching for variations on 38
word-processing application, indicating preferred 114
www.lexis.com command 134

Z
Zoom feature 121